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Ascend Customer Service
When you contact Ascend Customer Service, make sure you have this
information:

n The product name and model
n The software version
n The operating system and version
n The type of installation (server, workstation, standalone)
n A description of the problem

How to contact Ascend Customer Service

Ways to contact Ascend
Customer Service

Telephone number or address

Telephone in the United States 800-ASCEND-4      800-272-3634

Telephone outside the United States 510-769-8027

Austria/Germany/Switzerland (+33) 492 96 5672

Benelux (+33) 492 96 5674

France (+33) 492 96 5673

Italy (+33) 492 96 5676

Japan (+81) 3 5325 7397

Middle East/Africa (+33) 492 96 5679

Scandinavia (+33) 492 96 5677

Spain/Portugal (+33) 492 96 5675

UK (+33) 492 96 5671

E-mail support@ascend.com

Email (outside US) EMEAsupport@ascend.com

Facsimile (FAX) 510-814-2300

Customer Support BBS by modem 510-814-2302

You can also contact the Ascend main office by dialing 510-769-6001, or you
can write to Ascend at the following address:
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Ascend Communications, Inc.
1701 Harbor Parkway
Alameda, CA 94502

Need information on new features and products?
We are committed to constantly improving our products. You can find out about
new features and product improvement as follows:

n For the latest information on the Ascend product line, visit our site on the
World Wide Web:  http://www.ascend.com/

n For software upgrades, release notes, and addenda to this manual, visit our
FTP site:  ftp.ascend.com
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3 Getting Started with NavisAccess 1

About NavisAccess
Ascend NavisAccess ™  network management software is the next generation tool
for managing carrier networks, Points of Presence (POPs) and enterprise
networks. It is the only end-to-end, multi-vendor solution designed specifically
for ISPs, carriers and corporations who need to support a variety of network
access devices and services. Features such as discovery and mapping,
configuration management, performance measurement and fault monitoring
provide customized information about the network -- ranging from the “big
picture” view of the enterprise to the details about the performance on a single
modem port.

Among the features of NavisAccess are:

n Access Watch, the first and only software solution that summarizes key
remote access operating parameters for elements and groups of elements.

n Enterprise-wide discovery and mapping.

n Centralized, remote management of devices and device groups, including
chassis, software and configuration file change control.

n An extensive suite of performance management tools.

n Fault detection tools that continually monitor all aspects of the network.

n Multi-vendor device support.

For a complete discussion of NavisAccess features, consult the NavisAccess
User Guide (available both on-line and in printed form) or the NavisAccess
online help.
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What’s New in Version 4.1
NavisAccess 4.1 extends the industry-leading functionality of NavisAccess
management software by providing new features and enhancements, many based
on end-user suggestions.

n Improved system performance.

n A greatly enhanced selection of historical reports, including the following
new reports:

Top N Calls report – Displays the top “N” users or devices based on
selected criteria. Criteria include total calls, call duration, connect speed,
authorization failures, etc.

Call Rate Detail report – Displays call statistics over a selected time
range.  Statistics include total calls, call duration, connect speed,
authorization failures, etc.

Calls by DNIS/NAS report – Displays call statistics based on phone
number called (DNIS) or device name (NAS). Statistics include total calls,
call duration, connect speed, authorization failures, etc.

User Detail report – Displays call statistics based on user name. Statistics
include total calls, call duration, connect speed, authorization failures, etc.

Modem Site Utilization report – Displays call statistics in half-hour
intervals.  Statistics include the number of Call Starts, Call Ends, Failed
Calls and a Max Peak value, which is the most calls being made at any
moment during the half-hour monitoring period.

Call Rate report – Graphs the number of calls received by devices or
groups of devices.

Connect Speed report – Graphs the average dial-up connection rate by
devices or groups of devices.

Authentication Delay report – Graphs the average time required by users
to authenticate, by devices or groups of devices.

Failed Calls Report – Graphs the number of calls failures by devices or
groups of devices.

n A DS1 application that reports real-time statistics for T1 and E1 line
utilization.
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n The Audit Trails and Audit Trail History applets which monitor and record
user actions in real-time and historically.

n New options for the Database Groomer that allow you to specify the kinds of
data to purge from the database.

n The Community Manager applet, which allows you to set the read- and read-
write community strings for multiple devices at the same time.

n An additional option to the Device Change Control schedule that
automatically saves the configuration file(s) downloaded.

For full details on new features and functionality, consult the NavisAccess User
Guide or NavisAccess online help.

Device Preparation
Before NavisAccess can be used with Ascend devices or devices from other
vendors, certain device-specific prerequisites must be met.

See Chapter 4, "Preparing to Use NavisAccess With Ascend Devices" for
information on preparing Ascend devices for use.

For non-Ascend devices (including Cisco routers and switches, and routers from
3Com, Bay/Wellfleet, Digital and Novell MPR), see the NavisAccess User
Guide or online help in the sections entitled, "Special Considerations for [router
type]."

Product Licensing
You must purchase a separate copy of NavisAccess for EACH user that will be
concurrently logging in to the server.

NavisAccess Options
The following NavisAccess options are available:

n NavisAccess:Trend
NavisAccess:Trend provides reporting capabilities for historical system trend
analysis. Includes an HTML reporting option.

n NavisAccess:IP
NavisAccess:IP provides multi-vendor device capabilities, allowing you to
manage devices from Cisco (routers and switches) and routers from 3Com,
Bay Networks and Digital Equipment Corporation.
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Both options must be purchased separately and installed separately, after
installing NavisAccess.   One copy of NavisAccess:Trend and/or NavisAccess:IP
is required per server.  There is no user log-in limit.

Standalone vs. HP OpenView

Certain features of NavisAccess are not available when running on HP
OpenView.  This is because NavisAccess leverages OpenView features where
available and thereby avoids duplicating functionality.

The following  topics describe which NavisAccess features are not found on HP
OpenView and explains where that functionality is available.

Device Discovery

The NavisAccess Explorer and New Device features, which are used to locate
network devices and add them to the NavisAccess database, are not available.
HP OpenView uses its own network discovery features to locate devices, and
NavisAccess incorporates these devices into its own database on a user-selected
basis.

To enter devices in the NavisAccess database, from the OpenView map menu
bar select NavisAccess > Devices > Discover to open the Discover Devices
window.
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Click the [Scan DB] button to load devices from the OpenView database into the
Discover Devices window.  Select the devices you wish to enter into the
NavisAccess database.  Click the [Discover] button to enter the devices.

All Discovered devices will display the NavisAccess icon on the OpenView
map, as in this example:

MIB Compiler and MIB Browser

The NavisAccess MIB Compiler and MIB Browser are not available.  The
OpenView application corresponding to the MIB Compiler is the Load/Unload
MIBs application, located under Options > Load/Unload MIBs on the
OpenView map menu bar.   The OpenView application corresponding to the
MIB Browser is the MIB Application Builder, located under Options > MIB
Application Builder on the OpenView map menu bar.

Event Viewer

The NavisAccess Event Viewer, which displays system Traps and messages, is
not available.  Traps are displayed via the OpenView event system.  However,
other NavisAccess fault management features are available.  These include the
Alarm Monitor, Alert, Event Report and Incident Monitor. Consult the
NavisAccess User Guide or online for details on these applications.
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4 Installing NavisAccess on Solaris 2

Installing NavisAccess for Solaris

!
NOTE: The following information is critical to proper
NavisAccess operation.  Please read the following sections
carefully before beginning your NavisAccess installation.

Without proper environment configuration, NavisAccess will not
be able to operate.  This chapter refers to installing NavisAccess
as a standalone product on Solaris.  To install under HP
OpenView, please see Chapter 3, “Installing NavisAccess on HP
OpenView.”

HP OpenView NOTE: Documentation specific to using
NavisAccess on the HP OpenView platform is indicated in this
manual by an OpenView icon, as shown at left.

Unless specifically indicated as an OpenView application, all
functionality refers to NavisAccess.  For example, both
NavisAccess and OpenView have a MIB compiler. The
OpenView MIB compiler will be specifically referred to as such.

System Requirements
To install and operate NavisAccess for Solaris, the following hardware and
software minimum requirements must be satisfied.  Note that if multiple
workstations will be logging in to one server, additional memory and processor
power is recommended for optimal performance on the server.

To support up to 500 ports:

System Sun Enterprise 150 w/ Single
167MHz or higher processor

System Memory (RAM) 128 Meg RAM

Free Disk Space 2 GB
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Video Resolution 1152x900 minimum resolution

OS version Solaris 2.5.1

To support up to 1000 ports:

System Sun Enterprise 2 Dual 167MHz or
higher processor

System Memory (RAM) 256 Meg RAM

Free Disk Space 4 GB

Video Resolution 1152x900 minimum resolution

OS version Solaris 2.5.1

To support up to 5000 ports:

System Sun Enterprise 3000 with 1
UltaSPARC II 336MHZ

System Memory (RAM) 256meg RAM

Free Disk Space 10 GB

Video Resolution 1152x900 minimum resolution

OS version Solaris 2.5.1

To support up to 10,000 ports:

System Sun Enterprise 3000 with 2
UltaSPARC II 336MHZ or more

System Memory (RAM) 512 Meg RAM

Free Disk Space 20 GB

Video Resolution 1152x900 minimum resolution

OS version Solaris 2.5.1
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Getting Ready to Install: Things to Know

Please read the following prerequisites and preparatory steps before beginning
installation of NavisAccess.

n Installation checks for the environment variable AutoBahn to find a previous
installation.  If there is a previous installation, AutoBahn must be set to the
installed directory. Otherwise, it must not be set.   This can be checked with
the command

echo $AutoBahn

If Autobahn is not set, nothing will be returned by this command.

n AutoBahn can be unset using the following command:

unset AutoBahn

n Installation will ask for the home directory of the Common Desktop
Environment (CDE) if it is not installed in the default directory /usr/dt.

n Installation can be run from an X terminal or a character terminal.

n All NavisAccess files are installed with owner and group of the user who
installed it.  The files are given 755 as mode.

n NavisAccess must be installed by a super user.

n Installation creates three required daemons.  They are:

 Registry daemon windu_registryd40

Service daemon windu_serviced40

Database engine daemon dbeng50

After installation, these daemons will be started when the system is booted
and stopped when it is shut down.  Installation also prepares the Event
Dispatcher service (edispatcher) to be started and stopped by the Service
daemon.

If there is no previous installation (i.e. AutoBahn is not set), installation will
assume that all the above four entities are not running.  If there is a previous
installation (i.e., AutoBahn is set), installation will stop them if they are
running.
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n Installation creates the following files and directories:

S99windu and S99ascendDBeng in directory /etc/rc2.d

K99windu and K99ascendDBeng in directory /etc/rc0.d

windu and ascendDBeng in directory /etc/init.d

windu in directory /var/adm

n Note the following start and stop syntax for NavisAccess services.
edispatcher  -start
edispatcher  -stop
imc   -start
imc   -stop
eventstreamer  -start
eventstreamer  -stop
These services should not be killed.   Also, you should stop all other
services prior to stopping the edispatcher service.

n To start/stop the database engine daemon manually, use the following
commands:

 /etc/rc2.d/S99ascendDBeng start
 /etc/rc0.d/K99ascendDBeng stop

n In order to use the NavisAccess TFTP server, you must comment out the tftp
line in the /etc/inetd.conf file by entering a number sign (#) in front of the
line.  This line will look similar to the following:
tftp dgram udp wait root /usr/lbin/tftpd
tftpd/opt/ignite/var/opt/ignite

n There is a shell-script file, start_all.ksh, in the installed directory of
NavisAccess.  Use this file as a guideline to start all the background jobs
which are required to be run before starting NavisAccess.
To start the services, open a terminal session, switch to the NavisAccess
installation directory and enter:

start_all.ksh

Use the shell-script file stop_all.ksh in the NavisAccess installed directory
as a guideline to stop the background jobs started by start_all.ksh.
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NavisAccess Installation Step Summary : Solaris Standalone

Use this summary as a checklist to ensure you follow all the steps for
proper installation.  Failure to follow all the steps outlined below may
lead to problems starting or using NavisAccess.  Detailed installation
instructions follow this list.

Prerequisites to Installation:

q  Solaris Operating System must be installed.

q  CDE must be installed.

Installation Steps:

Step 1: q   Set System Semaphores

Step 2: q   Begin installation from the CD

Step 3: q   Continue with installation – Log file created

Step 4: q   Updating environment variables

Step 5: q   Reboot system

Step 6: q   Define environment variables

Step 7: q   Check LD_LIBRARY_PATH

Step 8: q   Compile MIBs.
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NavisAccess Installation Steps: Solaris Standalone

NOTE: The follow steps apply if you are installing NavisAccess for the first
time.  If you are upgrading or re-installing on a system that already contains
NavisAccess, please refer to the following section beginning, “NavisAccess
Upgrade Step Summary,” on page 26.

Please follow all of the steps below to insure proper installation of NavisAccess.
You can use the check boxes to mark your progress.

q  STEP 1:  Set Semaphores.

1.1 Changes must be made to the Solaris Semaphore settings to run
NavisAccess.  Please use the following chart as a guideline.  Note that your
settings may not be the same as the Solaris default settings.

SEMAPHORE Add this value to current setting Solaris
default

Seminfo_semmap Add 50  (for example, if your current
value is 10, add 50 for a total of 60)

10

Seminfo_semmni Add 50 10

Seminfo_semmns Add 120 60

Seminfo_semmnu Add 60 30

Seminfo_semmsl Add 50 25

Seminfo_semopm Add 50 10

Seminfo_semume Add 50 10

The following values are absolutes:

Seminfo_semvmx Set to 65535.

Seminfo_semaem Set to 32768.

To check your current settings, enter the following command from the etc
directory:
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sysdef -i

To change a semaphore setting, add a line to the /etc/system file.  The
following example sets the seminfo_semmni variable to 60:

set semsys:seminfo_semmni=60

To edit the system file, enter

vi system

or use any suitable text editor.  Semaphore settings will not take effect until
you reboot the machine.

If you do not have any default semaphore settings in the system file, the
following parameters may be used as a starting point.  Enter the following
text exactly as shown into the system file.

set semsys:seminfo_semmap=60
set semsys:seminfo_semmni=60
set semsys:seminfo_semmns=180
set semsys:seminfo_semmnu=90
set semsys:seminfo_semmsl=75
set semsys:seminfo_semopm=60
set semsys:seminfo_semume=60
set semsys:seminfo_semvmx=65535
set semsys:seminfo_semaem=32768

1.2 Save the new semaphore settings when complete.

q  STEP 2:  Begin installation from the CD.

2.1 Insert the installation CD into the drive.

2.2 Change to the directory where the CD is mounted (usually /cdrom).

2.3 Change to the NavisAccess directory and run the installation file by
entering:
./install.ksh
A welcome message displays, followed by a prompt to enter a user name.

2.4 Enter User Name.

2.5 Enter Company Name at the prompt.

2.6 At this point, the script will check to see that the proper services are present
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in the /etc/services file.

If any of the services are not currently in the services file, setup will prompt
you to enter the line in the services file.

For example, you may see a message similar to:

tftp service is not present in /etc/services
Please enter the line “tftp 69/udp” in /etc/services

Make a note of the needed changes and edit the /etc/services file by adding
the line as presented to you.

2.7 If any changes were required, after making them restart the install script, as
in Step 2.3.

2.8 You will be prompted to enter the directory path for NavisAccess. The
directory must be all lower case as specified by the program, and it must be
a full path.  For example:

/usr/target_directory

NOTE: The software installs to the exact directory path you specify.  If
you specify  /opt/navisaccess  all of the NavisAccess files will be placed
directly in /opt/navisaccess.  You should always specify a specific new
sub-directory to which NavisAccess should be installed, such as
/opt/navisaccess, because all files in the final directory will be deleted.

2.9 A message similar to the following will appear:

You have given the following options:
User name is (username)
Company name is (company name)
Target directory is (/usr/target_directory)
Do you want to continue?[y/n]

Select [Y] to continue or [N] to quit the installation.

2.10 The installation script will look for any files that may exist in the directory
that has been chosen for installation. If any files exist, a message similar to
the following will appear:

All files in the target directory will be
removed. Continue[c]or Quit [q]?

2.11 If Continue is selected, all files in the target directory will be deleted.
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q  STEP 3: Continue with installation – Log file created.

3.1 A log file will be created in the /target/directory/ascend_install.log
directory containing information such as user name, company name, target
directory, and other installation information.

3.2 The system is checked for proper system resources such as Disk space.

3.3 The script will start copying files to the target directory.  A message will
indicate files are being copied.

3.4 When the file transfer is complete, the registry and service daemons will
start.  Confirmation messages will appear as they are confirmed.  When
complete, a message similar to the following appears:

A file .NavisAccessProfile in the directory
/target/directory has been created. This file contains
all of the environment variables which are required to
run NavisAccess.

q  STEP 4: Updating environment variables.

4.1 Installation will ask if the environment variables should be made system-
wide environment variables.  If "Yes" is chosen, then all these variables are
available to any user who logs in to the CDE.  There will be no need to
have these variables in the user profile file.

4.2 If you have a .profile, a message prompt will ask:

Do you want to update your .profile ?[y/n]

When yes is selected, the .profile must get updated and contain all of the
environment variables that are necessary for the application to run and
perform correctly.

4.3 After the .profile file has been updated, the previous profile will be backed
up and a message similar to the following will appear:

A copy of your previous .profile has been placed in .profile.ascend.bak

4.4 Messages will appear indicating the Edispatcher is being registered and the
database engine is initialized as daemon.
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q  STEP 5: Reboot.

5.1 Upon completion of the above steps, an Installation over message will
appear.

Reboot the machine at this time.

q  STEP 6: Define environment variables.

6.1 The following environment variables are defined by installation:

AutoBahn
WUHOME
SQLANY
WINDU
The following environment variables need to be augmented:

PATH

LD_LIBRARY_PATH

Installation creates a file .NavisAccessProfile in the installation directory
which has all the above variables defined in sh and ksh syntax. Please
make sure they are defined for all users who will be using NavisAccess.

q  STEP 7: Check the LD_LIBRARY_PATH environment variables.

7.1 Before running NavisAccess, make sure that LD_LIBRARY_PATH
environment variable in the .NavisAccessProfile has reference to standard
system libraries /usr/lib, /usr/dt/lib and /usr/openwin/lib.  These
directories must be contained in your LD_LIBRARY_PATH.

7.2 To update the LD_LIBRARY_PATH variables, open a terminal window,
switch to the NavisAccess installation directory, and edit the profile by
entering

vi .NavisAccessProfile

or use a suitable text editor.



Installing on Solaris standalone

NavisAccess Getting Started                                                                                                       23

7.3 Enter the following text into the .NavisAccessProfile file.

LD_LIBRARY_PATH=/usr/lib:/usr/openwin/lib:/usr/dt/
lib;export LD_LIBRARY_PATH

PATH=/opt/SUNWspro/bin:$PATH:.:/usr/openwin;export
PATH

7.4 Save the file and close it.

q  STEP 8: Compile MIBs.

8.1 Before using NavisAccess, the necessary MIBs must be compiled.   To
compile the MIBs, open a Terminal session and switch to the NavisAccess
installation directory.

8.2 Run the NavisAccess profile by entering:

. ./.NavisAccessProfile

NOTE:  At this time, you may also wish to copy *.mib from
Navis_Installation_Directory/mibs/rfc up one level to the
Navis_Installation_Directory/mibs directory.  This will create a MIB-II
directory tree available from the MIB Browser to allow you to do your own
MIB browsing.

8.3 Start the NavisAccess services by running the following from the
NavisAccess installation directory:

start_all.ksh

8.4 Enter the following command from the NavisAccess installation directory
to open the MIB Compiler:

mibc

8.5 Click the [Compile] button.  The compilation process will begin and will be
displayed in the MIB compiler window.

Compiling of a MIB will generate messages reading: "Processing File:
<name of file>."

NOTE: The database engine (dbeng50) must be running while compiling
MIBs using the mibc command.  Once the system has been rebooted, the
dbeng50 daemon will automatically start.

However, if a an error dialog box “libsrmdb” appears stating “Unable to
open database,”  the dbeng50 has not started for some reason.  It can be
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started using the following:

/etc/rc2.d/S99ascendDBeng start

After starting dbeng50, run [Compile] again.

8.6 Upon completion of the compiling process, the MIB Compiler will write a
binary file and then build a Trap database.  If the entire process is
successful, a screen similar to the one below will be displayed.

NOTE: If you are not installing an evaluation copy of NavisAccess, you must
now install any option packages you have purchased for use with the
NavisAccess:Console.  Available option packages are:

n NavisAccess:Trend (historical reporting)

n NavisAccess:IP (multi-vendor support)

Starting NavisAccess: Solaris standalone
To start NavisAccess, the environment must be set and the server services must
be started.  Then the user application (GUI) can be started.  This can be started
on the server or any workstation logging in to the server.

Starting NavisAccess

NOTE: The following procedure must be run by ROOT.
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1. Open a Terminal session and switch to the NavisAccess installation
directory.

2. Run the following script:

. ./.NavisAccessProfile
This script activates the necessary environment variables and paths for
NavisAccess.

3. Run the following script:

start_all.ksh

This is a shell-script file located in the installed directory of NavisAccess.
Use this file as a guideline to start all the background jobs which are
required to be run before starting NavisAccess.

This will start the required services.

4. Enter the following:

srm

The srm executable starts the NavisAccess graphical user interface.

5. The first time you start NavisAccess, the default User Name and password
are Admin and Admin.

NOTE:  Every console user of NavisAccess must have their own account
and should be logged in as such. Do not run multiple instances of
NavisAccess from the same login ID.

A user who Xterms into the server machine (running .NavisAccessProfile
and the start_all.ksh under ‘root’), must use a different login than other
users currently logged in to that server machine.
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NavisAccess Upgrade Step Summary : Solaris Standalone

 Use this summary as a check list to ensure you follow all the steps for
proper installation.  Failure to follow all the steps outlined below may
lead to problems starting or using NavisAccess.  Detailed installation
instructions follow this list.

Prerequisites to Installation:

q  Solaris Operating System  must be installed.

q  CDE must be installed.

Upgrade Steps:

Step 1: q   Shut down all running NavisAccess services.

Step 2: q   Set System Semaphores

Step 3: q   Begin installation from the CD

Step 4: q   Reusing the existing database.

Step 5: q   Continue with installation – Log file created

Step 6: q   Updating environment variables

Step 7: q   Reboot system

Step 8: q   Define environment variables

Step 9: q   Check LD_LIBRARY_PATH

Step 10: q   Compile MIBs.
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NavisAccess Upgrade Steps: Solaris Standalone

NOTE: The follow steps apply if you are:

n Upgrading from a previous version of NavisAccess

n Re-installing a copy of NavisAccess

n Installing a live copy to update an evaluation copy.

If you are installing on a system that has never contained NavisAccess, please
refer to the previous section, “NavisAccess Installation Step Summary,” on page
17.

Please follow all of the steps below to insure proper installation of NavisAccess.
You can use the check boxes to mark your progress.

q  STEP 1:  Shut down all running NavisAccess services.

1.1 Stop the NavisAccess services, database engine and windu services using
the following commands:

stop_all.ksh    [to stop the services]

dbstop   [to stop the database engine]

/etc/rc0.d/K99windu stop  [to stop all windu services]

Also check if any other windu clients are running. If they are, you must kill
them before you proceed.  One way to do this is as follows:

ps –aef | grep windu_client

Note the process ID of windu_clientd40 and kill it as follows:

kill  -9 <windu_clientd40-pid>
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q  STEP 2:  Set Semaphores.

2.1 Changes must be made to the Solaris Semaphore settings to run
NavisAccess.  Please use the following chart as a guideline.  Note that your
settings may not be the same as the Solaris default settings.

SEMAPHORE Add this value to current setting Solaris
default

Seminfo_semmap Add 50  (for example, if your current
value is 10, add 50 for a total of 60)

10

Seminfo_semmni Add 50 10

Seminfo_semmns Add 120 60

Seminfo_semmnu Add 60 30

Seminfo_semmsl Add 50 25

Seminfo_semopm Add 50 10

Seminfo_semume Add 50 10

The following values are absolutes:

Seminfo_semvmx Set to 65535.

Seminfo_semaem Set to 32768.

To check your current settings, enter the following command from the etc
directory:

sysdef -i

To change a semaphore setting, add a line to the /etc/system file.  The
following example sets the seminfo_semmni variable to 60:

set semsys:seminfo_semmni=60

To edit the system file, enter

vi system

or use any suitable text editor.  Semaphore settings will not take effect until
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you reboot the machine.

If you do not have any default semaphore settings in the system file, the
following parameters may be used as a starting point.  Enter the following
text exactly as shown into the system file.

set semsys:seminfo_semmap=60
set semsys:seminfo_semmni=60
set semsys:seminfo_semmns=180
set semsys:seminfo_semmnu=90
set semsys:seminfo_semmsl=75
set semsys:seminfo_semopm=60
set semsys:seminfo_semume=60
set semsys:seminfo_semvmx=65535
set semsys:seminfo_semaem=32768

2.2 Save the new semaphore settings when complete.

q  STEP 3:  Begin  installation from the CD.

3.1 Insert the installation CD into the drive.

3.2 Change to the directory where the CD is mounted (usually /cdrom).

3.3 Change to the NavisAccess directory and run the installation file by
entering:
./install.ksh
A welcome message displays, followed by a prompt to enter a user name.

3.4 Enter User Name.

3.5 Enter Company Name at the prompt.

3.6 At this point, the script will check to see that the proper services are present
in the /etc/services file.

If any of the services are not currently in the services file, setup will prompt
you to enter the line in the services file.

For example, you may see a message similar to:

tftp service is not present in /etc/services
Please enter the line “tftp 69/udp” in /etc/services

Make a note of the needed changes and edit the /etc/services file by adding
the line as presented to you.
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3.7 If any changes were required, after making them restart the install script, as
in Step 3.3.

3.8 You will be prompted to enter the directory path for NavisAccess. The
directory must be all lower case as specified by the program, and it must be
a full path.  For example:

/usr/target_directory

NOTE: The software installs to the exact directory path you specify.  If
you specify  /opt/navisaccess  all of the NavisAccess files will be placed
directly in /opt/navisaccess.  You should always specify a specific new
sub-directory to which NavisAccess should be installed, such as
/opt/navisaccess, because all files in the final directory will be deleted.

3.9 A message similar to the following will appear:

You have given the following options:
User name is (username)
Company name is (company name)
Target directory is (/usr/target_directory)
Do you want to continue?[y/n]

Select [Y] to continue or [N] to quit the installation.

3.10 The installation script will look for any files that may exist in the directory
that has been chosen for installation. If any files exist, a message similar to
the following will appear:

All files in the target directory will be
removed. Continue[c]or Quit [q]?

3.11 If Continue is selected, all files in the target directory will be deleted.

q  STEP 4: Reusing the existing database.

4.1 If you are upgrading from NavisAccess 4.0 and AutoBahn is already set
(e.g., at /usr/navisaccess), the installation script provides an option to
reuse the existing database.  The database file is ascend.db.  This file
contains device information, configuration files,  historical trending data,
etc.  If you do not reuse the database, all information you have gathered
will be lost.

The installation script will copy and upgrade the existing database to
support NavisAccess 4.1 (databases from NavisAccess 4.0 and 4.1 are not
compatible otherwise).
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A message similar to the following will appear:

(install.ksh) sensed an existing installation of
navisaccess at /usr/navisaccess

If you continue, the existing version cannot be
used.

Continue [c] or quit [q]?

Select [c] to reinstall NavisAccess.   Select [q] to quit installation.

If you are reinstalling, the database file will be backed up to a temporary
store.  The install script also advises that you back up the old database as
a safety mechanism.  At this point, you will be asked if you wish to reuse
the existing database.  Type “y” if you want to re-use the existing database
with the new installation.

If there is any previous installation, the script will check for installed
Daemons/services.  If any Daemons are currently running a message will
appear indicating this, and the Daemons will be stopped.

q  STEP 5: Continue with installation – Log file created.

5.1 A log file will be created in the /target/directory/ascend_install.log
directory containing information such as user name, company name, target
directory, and other installation information.

5.2 The system is checked for proper system resources such as Disk space.

5.3 The script will start copying files to the target directory.  A message will
indicate files are being copied.

5.4 When the file transfer is complete, the registry and service daemons will
start.  Confirmation messages will appear as they are confirmed.  When
complete, a message similar to the following appears:

A file .NavisAccessProfile in the directory
/target/directory has been created. This file contains
all of the environment variables which are required to
run NavisAccess.
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q  STEP 6: Updating environment variables.

6.1 Installation will ask if the environment variables should be made system-
wide environment variables.  If "Yes" is chosen, then all these variables are
available to any user who logs in to the CDE.  There will be no need to
have these variables in the user profile file.

6.2 If you have a .profile, a message prompt will ask:

Do you want to update your .profile ?[y/n]

When yes is selected, the existing .profile will get updated and contain all
of the environment variables that are necessary for the application to run
and perform correctly.

6.3 After the .profile file has been updated, the previous profile will be backed
up and a message similar to the following will appear:

A copy of your previous .profile has been placed in .profile.ascend.bak

6.4 Messages will appear indicating the Edispatcher is being registered and the
database engine is initialized as daemon.

6.5 If you are upgrading from version 4.0 and have chosen to save you
previous database file, the installation process will ask for your final
confirmation to retain the previous database.  A message similar to the
following appears:

… checking for the need of database
copy/upgradation.

Trying to copy old database (Ver: V...) into new
installation (Ver: V...)

q  STEP 7: Reboot.

7.1 Upon completion of the above steps, an Installation over message will
appear.

Reboot the machine at this time.
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q  STEP 8: Define environment variables.

8.1 The following environment variables are defined by installation:

AutoBahn

WUHOME

SQLANY

WINDU

The following environment variables need to be augmented:

PATH

LD_LIBRARY_PATH

Installation creates a file .NavisAccessProfile in the installation directory
which has all the above variables defined in sh and ksh syntax. Please
make sure they are defined for all users who will be using NavisAccess.

q  STEP 9: Check the LD_LIBRARY_PATH environment variables.

9.1 Before running NavisAccess, make sure that LD_LIBRARY_PATH
environment variable in the .NavisAccessProfile has reference to standard
system libraries /usr/lib, /usr/dt/lib and /usr/openwin/lib.  These
directories must be contained in your LD_LIBRARY_PATH.

9.2 To update the LD_LIBRARY_PATH variables, open a terminal window,
switch to the NavisAccess installation directory, and edit the profile by
entering

vi .NavisAccessProfile

or use a suitable text editor.

9.3 Enter the following text into the .NavisAccessProfile file.

LD_LIBRARY_PATH=/usr/lib:/usr/openwin/lib:/usr/dt/
lib;export LD_LIBRARY_PATH

PATH=/opt/SUNWspro/bin:$PATH:.:/usr/openwin;export
PATH

9.4 Save the file and close it.
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q  STEP 10: Compile MIBs.

10.1 Before using NavisAccess, the necessary MIBs must be compiled.   To
compile the MIBs, open a Terminal session and switch to the NavisAccess
installation directory.  You must complete this step, even if you have
compiled MIBs using a previous version of NavisAcccess.

10.2 Run the NavisAccess profile by entering:

. ./.NavisAccessProfile

NOTE:  At this time, you may also wish to copy *.mib from
Navis_Installation_Directory/mibs/rfc up one level to the
Navis_Installation_Directory/mibs directory.  This will create a MIB-II
directory tree available from the MIB Browser to allow you to do your own
MIB browsing.

10.3 Start the NavisAccess services by running the following from the
NavisAccess installation directory:

start_all.ksh

10.4 Enter the following command from the NavisAccess installation directory:

mibc

This opens the MIB Compiler.

10.5 Click the [Compile] button.  The compilation process will begin and will be
displayed in the MIB compiler window.  Compiling of a MIB will generate
messages reading: "Processing File: <name of file>."

NOTE: The database engine (dbeng50) must be running while compiling
MIBs using the mibc command.  Once the system has been rebooted, the
dbeng50 daemon will automatically start.

However, if a an error dialog box “libsrmdb” appears stating “Unable to
open database,”  the dbeng50 has not started for some reason.  It can be
started using the following:

/etc/rc2.d/S99ascendDBeng start

After starting dbeng50, run [Compile] again.

10.6 Upon completion of the compiling process, the MIB Compiler will write a
binary file and then build a Trap database.  If the entire process is
successful, a screen similar to the one below will be displayed.
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NOTE: If you are not installing an evaluation copy of NavisAccess, you must
now re-install any option packages you have purchased for use with the
NavisAccess:Console.  Available option packages are:

n NavisAccess:Trend (historical reporting)

n NavisAccess:IP (multi-vendor support)

Starting NavisAccess: Solaris standalone
To start NavisAccess,  the environment must be set and the server services must
be started.  Then the user application (GUI) can be started.  This can be started
on the server or any workstation logging in to the server.

Starting NavisAccess

NOTE: The following procedure must be run by ROOT.

1. Open a Terminal session and switch to the NavisAccess installation
directory.

2. Run the following script:

. ./.NavisAccessProfile
This script activates the necessary environment variables and paths for
NavisAccess.

3. Run the following script:
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start_all.ksh

This is a shell-script file located in the installed directory of NavisAccess.
Use this file as a guideline to start all the background jobs which are
required to be run before starting NavisAccess.

This will start the required services.

4. Enter the following:

srm

The srm executable starts the NavisAccess graphical user interface.

5. The first time you start NavisAccess, the default User Name and password
are Admin and Admin.

NOTE:  Every console user of NavisAccess must have their own account
and should be logged in as such. Do not run multiple instances of
NavisAccess from the same login ID.

A user who Xterms into the server machine (running .NavisAccessProfile
and the start_all.ksh under ‘root’), must use a different login than other
users currently logged in to that server machine.
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5 Installing NavisAccess on HP OpenView 3

!
NOTE: The following information is critical to proper
NavisAccess operation.  Please read the following sections
carefully before beginning your NavisAccess installation.

Without proper environment configuration, NavisAccess will not
be able to operate.  This chapter refers to installing NavisAccess
under HP OpenView.  To install as a standalone product on
Solaris, please see Chapter 2, “Installing NavisAccess on
Solaris.”

HP OpenView NOTE: Documentation specific to using
NavisAccess on the HP OpenView platform is indicated in this
manual by an OpenView icon, as shown at left.

Unless specifically indicated as an OpenView application, all
functionality refers to NavisAccess.  For example, both
NavisAccess and OpenView have a MIB compiler. The
OpenView MIB compiler will be specifically referred to as such.

System Requirements
To install and operate NavisAccess for Solaris on HP OpenView, the following
hardware and software minimum requirements must be satisfied.  Note that if
multiple workstations will be logging in to one server, additional memory and
processor power is recommended for optimal performance on the server.

To support up to 500 ports:

System Sun Enterprise 150 w/ Single
167MHz or higher processor

System Memory (RAM) 128 Meg RAM

Free Disk Space 2 GB
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Video Resolution 1152x900 minimum resolution

OS version Solaris 2.5.1

HPOV version 4.11

To support up to 1000 ports:

System Sun Enterprise 2 Dual 167MHz or
higher processor

System Memory (RAM) 256 Meg RAM

Free Disk Space 4 GB

Video Resolution 1152x900 minimum resolution

OS version Solaris 2.5.1

HPOV version 4.11

To support up to 5000 ports:

System Sun Enterprise 3000 with 1
UltaSPARC II 336MHZ

System Memory (RAM) 256meg RAM

Free Disk Space 10 GB

Video Resolution 1152x900 minimum resolution

OS version Solaris 2.5.1

HPOV version 4.11

To support up to 10,000 ports:

System Sun Enterprise 3000 with 2
UltaSPARC II 336MHZ or more

System Memory (RAM) 512 Meg RAM

Free Disk Space 20 GB

Video Resolution 1152x900 minimum resolution
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OS version Solaris 2.5.1

HPOV version 4.11

Getting Ready to Install: Things to Know

Please read the following prerequisites and preparatory steps before beginning
installation of NavisAccess.

n Installation checks for the environment variable AutoBahn to find a previous
installation.  If there is a previous installation, AutoBahn must be set to the
installed directory. Otherwise, it must not be set.   This can be checked with
the command

echo $AutoBahn

If Autobahn is not set, nothing will be returned by this command.

n AutoBahn can be unset using the following command:

unset AutoBahn

n Installation will ask for the home directory of the Common Desktop
Environment (CDE) if it is not installed in the default directory /usr/dt.

n Installation can be run from an X terminal or a character terminal.

n All NavisAccess files are installed with owner and group of the user who
installed it.  The files are given 755 as mode.

n NavisAccess must be installed by a super user.

n Installation creates three required daemons.  They are:

 Registry daemon windu_registryd40

Service daemon windu_serviced40

Database engine daemon dbeng50

After installation, these daemons will be started when the system is booted
and stopped when it is shut down.  Installation also prepares the Event
Dispatcher service (edispatcher) to be started and stopped by the Service
daemon.

If there is no previous installation (i.e. AutoBahn is not set), installation will
assume that all the above four entities are not running.  If there is a previous
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installation (i.e., AutoBahn is set), installation will stop them if they are
running.

n Installation creates the following files and directories:
S99windu and S99ascendDBeng in directory /etc/rc2.d
K99windu and K99ascendDBeng in directory /etc/rc0.d
windu and ascendDBeng in directory /etc/init.d
windu in directory /var/adm

n Note the following start and stop syntax for NavisAccess services.
edispatcher  -start
edispathcer  -stop
imc   -start
imc   -stop
eventstreamer  -start
eventstreamer  -stop

These services should not be killed.  To verify which services are running,
enter the command:

nastatus

n In order to use the NavisAccess TFTP server, you must comment out the tftp
line in the /etc/inetd.conf file by entering a number sign (#) in front of the
line.  This line will look similar to the following:
tftp dgram udp wait root /usr/lbin/tftpd
tftpd/opt/ignite/var/opt/ignite

n To start/stop the database engine daemon manually, use the following
commands:

 /etc/rc2.d/S99ascendDBeng start
 /etc/rc0.d/K99ascendDBeng stop

n There is a shell-script file, start_all.ksh, in the installed directory of
NavisAccess.  Use this file as a guideline to start all the background jobs
which are required to be run before starting NavisAccess.
To start the services, open a terminal session, switch to the NavisAccess
installation directory and enter:
start_all.ksh
Use the shell-script file stop_all.ksh in the NavisAccess installed directory
as a guideline to stop the background jobs started by start_all.ksh.
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NavisAccess Installation Step Summary : HP OpenView on Solaris

Use this summary as a check list to ensure you follow all the steps for
proper installation.  Failure to follow all the steps outlined below may
lead to problems starting or using NavisAccess.  Detailed installation
instructions follow this list.

Prerequisites to Installation:

q  Solaris Operating System must be installed.

q  HP OpenView on Solaris must be installed

q  CDE must be installed.

Installation Steps:

Step 1: q   Set System Semaphores

Step 2: q   Begin installation from the CD

Step 3: q   Continue with installation – Log file created

Step 4: q   Updating environment variables

Step 5: q   Reboot system

Step 6: q   Define environment variables

Step 7: q   Check LD_LIBRARY_PATH

Step 8: q   Perform HP OpenView integration steps.

Step 9: q   Configure NavisAccess Events for HP OpenView.

Step 10: q   Compile MIBs.
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NavisAccess Installation Steps: HP OpenView

NOTE: The follow steps apply if you are installing NavisAccess on HP
OpenView for the first time.  If you are upgrading or re-installing on a system
that already contains NavisAccess, please refer to the following section
beginning, “NavisAccess Upgrade Step Summary,” on page 53.

Please follow all of the steps below to insure proper installation of NavisAccess.
You can use the check boxes to mark your progress.

q  STEP 1:  Set Semaphores.

1.1 Changes must be made to the Solaris Semaphore settings to run
NavisAccess.  Please use the following chart as a guideline.  Note that your
settings may not be the same as the Solaris default settings.

SEMAPHORE Add this value to current setting Solaris
default

Seminfo_semmap Add 50  (for example, if your current
value is 10, add 50 for a total of 60)

10

Seminfo_semmni Add 50 10

Seminfo_semmns Add 120 60

Seminfo_semmnu Add 60 30

Seminfo_semmsl Add 50 25

Seminfo_semopm Add 50 10

Seminfo_semume Add 50 10

The following values are absolutes:

Seminfo_semvmx Set to 65535.

Seminfo_semaem Set to 32768.

To check your current settings, enter the following command from the etc
directory:
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sysdef -i

To change a semaphore setting, add a line to the /etc/system file.  The
following example sets the seminfo_semmni variable to 60:

set semsys:seminfo_semmni=60

To edit the system file, enter

vi system

or use any suitable text editor.  Semaphore settings will not take effect until
you reboot the machine.

If you do not have any default semaphore settings in the system file, the
following parameters may be used as a starting point.  Enter the following
text exactly as shown into the system file.

set semsys:seminfo_semmap=60
set semsys:seminfo_semmni=60
set semsys:seminfo_semmns=180
set semsys:seminfo_semmnu=90
set semsys:seminfo_semmsl=75
set semsys:seminfo_semopm=60
set semsys:seminfo_semume=60
set semsys:seminfo_semvmx=65535
set semsys:seminfo_semaem=32768

1.2 Save the new semaphore settings when complete.

q  STEP 2:  Begin  installation from the CD.

2.1 Insert the installation CD into the drive.

2.2 Change to the directory where the CD is mounted (usually /cdrom).

2.3 Change to the NavisAccess directory and run the installation file by
entering:
./install.ksh
A welcome message displays, followed by a prompt to enter a user name.

2.4 Enter User Name.

2.5 Enter Company Name at the prompt.

2.6 At this point, the script will check to see that the proper services are present
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in the /etc/services file.

If any of the services are not currently in the services file, setup will prompt
you to enter the line in the services file.

For example, you may see a message similar to:

tftp service is not present in /etc/services
Please enter the line “tftp 69/udp” in /etc/services

Make a note of the needed changes and edit the /etc/services file by adding
the line as presented to you.

2.7 If any changes were required, after making them restart the install script, as
in Step 2.3.

2.8 You will be prompted to enter the directory path for NavisAccess. The
directory must be all lower case as specified by the program, and it must be
a full path.  For example:

/usr/target_directory

NOTE: The software installs to the exact directory path you specify.  If
you specify  /opt/navisaccess  all of the NavisAccess files will be placed
directly in /opt/navisaccess.  You should always specify a specific new
sub-directory to which NavisAccess should be installed, such as
/opt/navisaccess, because all files in the final directory will be deleted.

2.9 A message similar to the following will appear:

You have given the following options:
User name is (username)
Company name is (company name)
Target directory is (/usr/target_directory)
Do you want to continue?[y/n]

Select [Y] to continue or [N] to quit the installation.

2.10 The installation script will look for any files that may exist in the directory
that has been chosen for installation. If any files exist, a message similar to
the following will appear:

All files in the target directory will be
removed. Continue[c]or Quit [q]?

2.11 If Continue is selected, all files in the target directory will be deleted.
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q  STEP 3: Continue with installation – Log file created.

3.1 A log file will be created in the /target/directory/ascend_install.log
directory containing information such as user name, company name, target
directory, and other installation information.

3.2 The system is checked for proper system resources such as Disk space.

3.3 The script will start copying files to the target directory.  A message will
indicate files are being copied.

3.4 When the file transfer is complete, the registry and service daemons will
start.  Confirmation messages will appear as they are confirmed.  When
complete, a message similar to the following appears:

A file .NavisAccessProfile in the directory
/target/directory has been created. This file contains
all of the environment variables which are required to
run NavisAccess.

q  STEP 4: Updating environment variables.

4.1 Installation will ask if the environment variables should be made system-
wide environment variables.  If "Yes" is chosen, then all these variables are
available to any user who logs in to the CDE.  There will be no need to
have these variables in the user profile file.

4.2 If you have a .profile, a message prompt will ask:

Do you want to update your .profile ?[y/n]

When yes is selected, the .profile must get updated and contain all of the
environment variables that are necessary for the application to run and
perform correctly.

4.3 After the .profile file has been updated, the previous profile will be backed
up and a message similar to the following will appear:

A copy of your previous .profile has been placed in .profile.ascend.bak

4.4 Messages will appear indicating the Edispatcher is being registered and the
database engine is initialized as daemon.
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q  STEP 5: Reboot.

5.1 Upon completion of the above steps, an Installation over message will
appear.

Reboot the machine at this time.

q  STEP 6: Define environment variables.

6.1 The following environment variables are defined by installation:

AutoBahn

WUHOME

SQLANY

WINDU

The following environment variables need to be augmented:

PATH

LD_LIBRARY_PATH

Installation creates a file .NavisAccessProfile in the installation directory
which has all the above variables defined in sh and ksh syntax. Please
make sure they are defined for all users who will be using NavisAccess.

q  STEP 7: Check the LD_LIBRARY_PATH environment variables.

7.1 Before running NavisAccess, make sure that LD_LIBRARY_PATH
environment variable in the .NavisAccessProfile has reference to standard
system libraries /usr/lib, /usr/dt/lib,  /usr/openwin/lib and /opt/OV/lib.
These directories must be contained in your LD_LIBRARY_PATH.

7.2 To update the LD_LIBRARY_PATH variables, open a terminal window,
switch to the NavisAccess installation directory, and edit the profile by
entering

vi .NavisAccessProfile

or use a suitable text editor.
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7.3 Enter the following text into the .NavisAccessProfile file.

LD_LIBRARY_PATH=/usr/lib:/usr/openwin/lib:/usr/dt/
lib:/opt/OV/lib;export LD_LIBRARY_PATH

PATH=/opt/SUNWspro/bin:$PATH:.:/usr/openwin;export
PATH

7.4 Save the file and close it.

q  STEP 8: Perform HP OpenView Integration Steps.

NOTE: OpenView must not be running when the following steps are
performed.

NOTE: The following procedures assume HP OpenView is already
installed. DO NOT proceed if OpenView is not installed.

8.1 Switch to the NavisAccess /ov directory under the NavisAccess install
directory.  Run the script, install-ov-integration.ksh.

8.2 The script will look for OpenView in a predetermined location:

/opt/OV/bin  /etc/opt/OV/share

8.3 The script then verifies that OpenView is not running, and a prompt allows
you to shut down OpenView if you have not done so already.

8.4 Files are then copied to appropriate directories.

8.5 OpenView commands are issued and the daemons are started.

8.6 Upon completion, you will receive a message similar to the following:

OpenView Integration Preparation Successful

8.7 Reboot the machine at this time.

q  STEP 9: Configure NavisAccess Events for HP OpenView

9.1 In order for NavisAccess generated events to be displayed in the HP
OpenView event viewer, the following steps are needed.

Open the IMC Configuration window by entering:

imccfg &

The IMC Configuration screen appears
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9.2 Click the Trap Handler tab.

9.3 Click the [Add] button, and in the IP Address field enter the following:

127.0.0.1

9.4 Click [OK] to close the Add window, then click [OK] to close the IMC
Configuration window.

q  STEP 10: Compile MIBs.

10.1 Before using NavisAccess, the necessary MIBs must be compiled.   To
compile the MIBs, open a Terminal session and switch to the NavisAccess
installation directory.

10.2 Run the NavisAccess profile by entering:

. ./.NavisAccessProfile

NOTE:  At this time, you may also wish to copy *.mib from
Navis_Installation_Directory/mibs/rfc up one level to the
Navis_Installation_Directory/mibs directory.  This will create a MIB-II
directory tree available from the MIB Browser to allow you to do your own
MIB browsing.
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10.3 Start the NavisAccess services by running the following from the
NavisAccess installation directory:
start_all.ksh

10.4 Enter the following command from the NavisAccess installation directory
to open the MIB Compiler:
mibc

10.5 Click the [Compile] button.  The compilation process will begin and will be
displayed in the MIB compiler window.

Compiling of a MIB will generate messages reading: "Processing File:
<name of file>."

NOTE: The database engine (dbeng50) must be running while compiling
MIBs using the mibc command.  Once the system has been rebooted, the
dbeng50 daemon will automatically start.

However, if a an error dialog box “libsrmdb” appears stating “Unable to
open database,”  the dbeng50 has not started for some reason.  It can be
started using the following:

/etc/rc2.d/S99ascendDBeng start

After starting dbeng50, run [Compile] again.

10.6 Upon completion of the compiling process, the MIB Compiler will write a
binary file and then build a Trap database.  If the entire process is
successful, a screen similar to the one below will be displayed.
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You are now ready to start NavisAccess.

NOTE: If you are not installing an evaluation copy of NavisAccess, you must
now install any option packages you have purchased for use with the
NavisAccess:Console.  Available option packages are:

n NavisAccess:Trend (historical reporting)

n NavisAccess:IP (multi-vendor support)

Starting NavisAccess: HP OpenView
There are two steps involved in starting NavisAccess on HP OpenView.  The
environment must be set and the server services must be started.  Then the user
application (GUI) can be started.  This can be started on the server or any
workstation logging in to the server.

Starting NavisAccess on HP OpenView

NOTE: The following procedure must be run by ROOT.

1. Open a Terminal session and switch to the NavisAccess installation
directory.

2. Run the following script:

. ./.NavisAccessProfile
This script activates the necessary environment variables and paths for
NavisAccess.

3. Run the following script:

start_all.ksh

This is a shell-script file located in the installed directory of NavisAccess.
Use this file as a guideline to start all the background jobs which are
required to be run before starting NavisAccess.

This will start the required services.

4. Enter the following at the command line:

ovw &

5. NavisAccess is now ready to run.  When you launch the HP OpenView
map, a NavisAccess menu item will appear on the map's main menu bar.
Select any NavisAccess application on the menu to start NavisAccess.

The first time you start NavisAccess, the default User Name and Password
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are Admin and Admin. 

See the NavisAccess Quick Tour in Chapter 5 for details on exploring
NavisAccess.

Preparing MIBs for use on OpenView.

When running on OpenView, NavisAccess integrates with the OpenView event
system.  There are additional steps and special considerations for MIBs on
OpenView.

To load MIBs in OpenView

1. From the OpenView map window, select Options > Load/Unload MIBs
to open the MIB loader.

2. Click the [Load] button to open the Load MIB From File window:



Installing on HP OpenView

52                                                                                                     NavisAccess Getting Started

3. From the Navis_Install/mibs/ascend directory, select ascend.mib and
click [OK] to load the MIB.  This must be the first MIB you load.

4. Click the [Load] button again, select navisaccess-ov.mib and click [OK] to
load it.

5. You may load any additional MIBs you wish to load, with the following
consideration.  You must load wan.mib before loading xdsl.mib,
adslcap.mib and/or sdsl.mib.
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NavisAccess Upgrade Step Summary : HP OpenView on Solaris

 Use this summary as a check list to ensure you follow all the steps for
proper installation.  Failure to follow all the steps outlined below may
lead to problems starting or using NavisAccess.  Detailed installation
instructions follow this list.

Prerequisites to Installation:

q  Solaris Operating System must be installed.

q  HP OpenView on Solaris must be installed

q  CDE must be installed.

Upgrade Steps:

Step 1: q   Shut down all running NavisAccess services.

Step 2: q   Set System Semaphores

Step 3: q   Begin installation from the CD

Step 4: q   Reusing the existing database.

Step 5: q   Continue with installation – Log file created

Step 6: q   Updating environment variables

Step 7: q   Reboot system

Step 8: q   Define environment variables

Step 9: q   Check LD_LIBRARY_PATH

Step 10: q   Perform HP OpenView integration steps.

Step 11: q   Configure NavisAccess Events for HP OpenView.

Step 12: q   Compile MIBs.
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NavisAccess Upgrade Steps: HP OpenView

NOTE: The follow steps apply if you are:

n Upgrading from a previous version of NavisAccess

n Re-installing a copy of NavisAccess

n Installing a live copy to update an evaluation copy.

If you are installing on a system that has never contained NavisAccess, please
refer to the previous section, “NavisAccess Installation Step Summary: HP
OpenView,” on page 41.

Please follow all of the steps below to insure proper installation of NavisAccess.
You can use the check boxes to mark your progress.

q  STEP 1:  Shut down all running NavisAccess services.

1.1 Stop the NavisAccess services, database engine and windu services using
the following commands:

stop_all.ksh    [to stop the services]

dbstop   [to stop the database engine]

/etc/rc0.d/K99windu stop  [to stop all windu services]

Also check if any other windu clients are running. If they are, you must kill
them before you proceed.  One way to do this is as follows:

ps –aef | grep windu_client

Note the process ID of windu_clientd40 and kill it as follows:

kill  -9 <windu_clientd40-pid>
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q  STEP 2:  Set Semaphores.

2.1 Changes must be made to the Solaris Semaphore settings to run
NavisAccess.  Please use the following chart as a guideline.  Note that your
settings may not be the same as the Solaris default settings.

SEMAPHORE Add this value to current setting Solaris
default

Seminfo_semmap Add 50  (for example, if your current
value is 10, add 50 for a total of 60)

10

Seminfo_semmni Add 50 10

Seminfo_semmns Add 120 60

Seminfo_semmnu Add 60 30

Seminfo_semmsl Add 50 25

Seminfo_semopm Add 50 10

Seminfo_semume Add 50 10

The following values are absolutes:

Seminfo_semvmx Set to 65535.

Seminfo_semaem Set to 32768.

To check your current settings, enter the following command from the etc
directory:

sysdef -i

To change a semaphore setting, add a line to the /etc/system file.  The
following example sets the seminfo_semmni variable to 60:

set semsys:seminfo_semmni=60

To edit the system file, enter

vi system

or use any suitable text editor.  Semaphore settings will not take effect until
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after you reboot the machine.

If you do not have any default semaphore settings in the system file, the
following parameters may be used as a starting point.  Enter the following
text exactly as shown into the system file.

set semsys:seminfo_semmap=60
set semsys:seminfo_semmni=60
set semsys:seminfo_semmns=180
set semsys:seminfo_semmnu=90
set semsys:seminfo_semmsl=75
set semsys:seminfo_semopm=60
set semsys:seminfo_semume=60
set semsys:seminfo_semvmx=65535
set semsys:seminfo_semaem=32768

2.2 Save the new semaphore settings when complete.

q  STEP 3:  Begin  installation from the CD.

3.1 Insert the installation CD into the drive.

3.2 Change to the directory where the CD is mounted (usually /cdrom).

3.3 Change to the NavisAccess directory and run the installation file by
entering:
./install.ksh
A welcome message displays, followed by a prompt to enter a user name.

3.4 Enter User Name.

3.5 Enter Company Name at the prompt.

3.6 At this point, the script will check to see that the proper services are present
in the /etc/services file.

If any of the services are not currently in the services file, setup will prompt
you to enter the line in the services file.

For example, you may see a message similar to:

tftp service is not present in /etc/services
Please enter the line “tftp 69/udp” in /etc/services

Make a note of the needed changes and edit the /etc/services file by adding
the line as presented to you.
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3.7 If any changes were required, after making them restart the install script, as
in Step 3.3.

3.8 You will be prompted to enter the directory path for NavisAccess. The
directory must be all lower case as specified by the program, and it must be
a full path.  For example:

/usr/target_directory

NOTE: The software installs to the exact directory path you specify.  If
you specify  /opt/navisaccess  all of the NavisAccess files will be placed
directly in /opt/navisaccess.  You should always specify a specific new
sub-directory to which NavisAccess should be installed, such as
/opt/navisaccess, because all files in the final directory will be deleted.

3.9 A message similar to the following will appear:

You have given the following options:
User name is (username)
Company name is (company name)
Target directory is (/usr/target_directory)
Do you want to continue?[y/n]

Select [Y] to continue or [N] to quit the installation.

3.10 The installation script will look for any files that may exist in the directory
that has been chosen for installation. If any files exist, a message similar to
the following will appear:

All files in the target directory will be
removed. Continue[c]or Quit [q]?

3.11 If Continue is selected, all files in the target directory will be deleted.

q  STEP 4: Reusing the existing database.

4.1 If you are upgrading from NavisAccess 4.0 and AutoBahn is already set
(e.g., at /usr/navisaccess), the installation script provides an option to
reuse the existing database.  The database file is ascend.db.  This file
contains device information, configuration files,  historical trending data,
etc.  If you do not reuse the database, all information you have gathered
will be lost.

The installation script will copy and upgrade the existing database to
support NavisAccess 4.1 (databases from NavisAccess 4.0 and 4.1 are not
compatible otherwise).
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A message similar to the following will appear:

(install.ksh) sensed an existing installation of
navisaccess at /usr/navisaccess

If you continue, the existing version cannot be
used.

Continue [c] or quit [q]?

Select [c] to reinstall NavisAccess.   Select [q] to quit installation.

If you are reinstalling, the database file will be backed up to a temporary
store.  The install script also advises that you back up the old database as
a safety mechanism.  At this point, you will be asked if you wish to reuse
the existing database.  Type “y” if you want to re-use the existing database
with the new installation.

If there is any previous installation, the script will check for installed
Daemons/services.  If any Daemons are currently running a message will
appear indicating this, and the Daemons will be stopped.

q  STEP 5: Continue with installation – Log file created.

5.1 A log file will be created in the /target/directory/ascend_install.log
directory containing information such as user name, company name, target
directory, and other installation information.

5.2 The system is checked for proper system resources such as Disk space.

5.3 The script will start copying files to the target directory.  A message will
indicate files are being copied.

5.4 When the file transfer is complete, the registry and service daemons will
start.  Confirmation messages will appear as they are confirmed.  When
complete, a message similar to the following appears:

A file .NavisAccessProfile in the directory
/target/directory has been created. This file contains
all of the environment variables which are required to
run NavisAccess.

q  STEP 6: Updating environment variables.

6.1 Installation will ask if the environment variables should be made system-
wide environment variables.  If "Yes" is chosen, then all these variables are
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available to any user who logs in to the CDE.  There will be no need to
have these variables in the user profile file.

6.2 If you have a .profile, a message prompt will ask:

Do you want to update your .profile ?[y/n]

When yes is selected, the .profile must get updated and contain all of the
environment variables that are necessary for the application to run and
perform correctly.

6.3 After the .profile file has been updated, the previous profile will be backed
up and a message similar to the following will appear:

A copy of your previous .profile has been placed in .profile.ascend.bak

6.4 Messages will appear indicating the Edispatcher is being registered and the
database engine is initialized as daemon.

q  STEP 7: Reboot.

7.1 Upon completion of the above steps, an Installation over message will
appear.

Reboot the machine at this time.

q  STEP 8: Define environment variables.

8.1 The following environment variables are defined by installation:

AutoBahn

WUHOME

SQLANY

WINDU

The following environment variables need to be augmented:

PATH

LD_LIBRARY_PATH

Installation creates a file .NavisAccessProfile in the installation directory
which has all the above variables defined in sh and ksh syntax. Please
make sure they are defined for all users who will be using NavisAccess.
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q  STEP 9: Check the LD_LIBRARY_PATH environment variables.

9.1 Before running NavisAccess, make sure that LD_LIBRARY_PATH
environment variable in the .NavisAccessProfile has reference to standard
system libraries /usr/lib, /usr/dt/lib,  /usr/openwin/lib and /opt/OV/lib.
These directories must be contained in your LD_LIBRARY_PATH.

9.2 To update the LD_LIBRARY_PATH variables, open a terminal window,
switch to the NavisAccess installation directory, and edit the profile by
entering

vi .NavisAccessProfile

or use a suitable text editor.

9.3 Enter the following text into the .NavisAccessProfile file.

LD_LIBRARY_PATH=/usr/lib:/usr/openwin/lib:/usr/dt/
lib:/opt/OV/lib;export LD_LIBRARY_PATH

PATH=/opt/SUNWspro/bin:$PATH:.:/usr/openwin;export
PATH

9.4 Save the file and close it.

q  STEP 10: Perform HP OpenView Integration Steps.

NOTE: OpenView must not be running when the following steps are
performed.

NOTE: The following procedures assume HP OpenView is already
installed. DO NOT proceed if OpenView is not installed.

10.1 Switch to the NavisAccess /ov directory under the NavisAccess install
directory.  Run the script, install-ov-integration.ksh.

10.2 The script will look for OpenView in a predetermined location:

/opt/OV/bin  /etc/opt/OV/share

10.3 The script then verifies that OpenView is not running, and a prompt allows
you to shut down OpenView if you have not done so already.

10.4 Files are then copied to appropriate directories.

10.5 OpenView commands are issued and the daemons are started.

10.6 Upon completion, you will receive a message similar to the following:
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OpenView Integration Preparation Successful

10.7 Reboot the machine at this time.

q  STEP 11: Configure NavisAccess Events for HP OpenView

11.1 In order for NavisAccess generated events to be displayed in the HP
OpenView event viewer, the following steps are needed.

Open the IMC Configuration window by entering:

imccfg &

The IMC Configuration screen appears

11.2 Click the Trap Handler tab.

11.3 Click the [Add] button, and in the IP Address field enter the following:

127.0.0.1

11.4 Click [OK] to close the Add window, then click [OK] to close the IMC
Configuration window.
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q  STEP 12: Compile MIBs.

12.1 Before using NavisAccess, the necessary MIBs must be compiled.   To
compile the MIBs, open a Terminal session and switch to the NavisAccess
installation directory.

12.2 Run the NavisAccess profile by entering:

. ./.NavisAccessProfile

NOTE:  At this time, you may also wish to copy *.mib from
Navis_Installation_Directory/mibs/rfc up one level to the
Navis_Installation_Directory/mibs directory.  This will create a MIB-II
directory tree available from the MIB Browser to allow you to do your own
MIB browsing.

12.3 Start the NavisAccess services by running the following from the
NavisAccess installation directory:

start_all.ksh

12.4 Enter the following command from the NavisAccess installation directory
to open the MIB Compiler:

mibc

12.5 Click the [Compile] button.  The compilation process will begin and will be
displayed in the MIB compiler window.

Compiling of a MIB will generate messages reading: "Processing File:
<name of file>."

NOTE: The database engine (dbeng50) must be running while compiling
MIBs using the mibc command.  Once the system has been rebooted, the
dbeng50 daemon will automatically start.

However, if a an error dialog box “libsrmdb” appears stating “Unable to
open database,”  the dbeng50 has not started for some reason.  It can be
started using the following:

/etc/rc2.d/S99ascendDBeng start

After starting dbeng50, run [Compile] again.

12.6 Upon completion of the compiling process, the MIB Compiler will write a
binary file and then build a Trap database.  If the entire process is
successful, a screen similar to the one below will be displayed.
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You are now ready to start NavisAccess.

NOTE: If you are not installing an evaluation copy of NavisAccess, you must
now install any option packages you have purchased for use with the
NavisAccess:Console.  Available option packages are:

n NavisAccess:Trend (historical reporting)

n NavisAccess:IP (multi-vendor support)

Starting NavisAccess: HP OpenView
To start NavisAccess on HP OpenView,  the environment must be set and the
server services must be started.  Then the user application (GUI) can be started.
This can be started on the server or any workstation logging in to the server.

Starting NavisAccess on HP OpenView

NOTE: The following procedure must be run by ROOT.

1. Open a Terminal session and switch to the NavisAccess installation
directory.

2. Run the following script:

. ./.NavisAccessProfile
This script activates the necessary environment variables and paths for
NavisAccess.
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3. Run the following script:

start_all.ksh

This is a shell-script file located in the installed directory of NavisAccess.
Use this file as a guideline to start all the background jobs which are
required to be run before starting NavisAccess.

This will start the required services.

4. Enter the following at the command line:

ovw &

5. NavisAccess is now ready to run.  When you launch the HP OpenView
map, a NavisAccess menu item will appear on the map's main menu bar.
Select any NavisAccess application on the menu to start NavisAccess.

The first time you start NavisAccess, the default User Name and Password
are Admin and Admin. 

See the NavisAccess Quick Tour in Chapter 5 for details on exploring
NavisAccess.
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Preparing MIBs for use on OpenView.

When running on OpenView, NavisAccess integrates with the OpenView event
system.  There are additional steps and special considerations needed for MIBs
on OpenView.

To load MIBs in OpenView

1. From the OpenView map window, select Options > Load/Unload MIBs
to open the MIB loader.

2. Click the [Load] button to open the Load MIB From File window:
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3. From the Navis_Install/mibs/ascend directory, select ascend.mib and
click [OK] to load the MIB.  This must be the first MIB you load.

4. Click the [Load] button again, select navisaccess-ov.mib and click [OK] to
load it.

5. You may load any additional MIBs you wish to load, with the following
consideration.  You must load wan.mib before loading xdsl.mib,
adslcap.mib and/or sdsl.mib.
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NavisAccess Events in HP OpenView
NavisAccess events can be configured using HP OpenView.  There are two
important facts to consider when deciding whether or not to configure events.

n If events are not configured in OpenView, they will appear in the OpenView
event window in a format that is not fully edited.  The event message will be
located within a larger string of data. For example, below is a typical
message that would appear.  For this illustration, the event message has been
underlined.

Wed Sep 17 08:15:56  150.50.1.1  NO TRAPD.CONF FMT
FOR .1.3.6.1.4.529.729.3.0.6 ARGS(4): [1]
private.ascendInternal.navisAccess.navisAccessAlarm
.1 (OctetString): An IP packet was discarded
because there was no route to its destination  [2]
private.ascendInternal.navisAccess.navisAccessAlarm
.2 (OctetString): IP No Route To Destination  [3]
private.ascendInternal.navisAccess.navisAccessAlarm
.3 (Integer): 5

n If you decide to configure events in OpenView, you must configure all events
contained in a given NavisAccess Enterprise ID.  If you configure only some
of the events, any unconfigured events will not appear in the OpenView
Event Viewer.

For further details, see the event configuration steps below.

Configuring Events

1. From the OpenView map, select Options > Event Configuration to open
the Event Configuration window.  NavisAccess events are grouped into
various Enterprises listed in the window.  The Enterprise IDs displayed will
vary based on the MIBs you have loaded.
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2. Select one of the Enterprises. The specific events will display in the Event
Identification section in the lower half of the window.

3. Select a specific Event Name by double-clicking on it.  This will open the
Event Configurator window, as shown below.
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A number of configuration options can be set.  Consult the OpenView help
for full details.  If you wish to display the event message as configured in
NavisAccess, enter

$1

in the Event Log Message field.  This will display the event message in a
properly edited format.

Note, that if you configure one Event Name in an Enterprise, you must
configure all the Event Names in the Enterprise.  If you do not configure
them all, any unconfigured events will not appear in the OpenView Event
Viewer.
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6 Preparing to use NavisAccess
with Ascend devices 4

Preparation Checklist: MAX, MAX TNT, Pipeline
Before NavisAccess can be used with Ascend MAX, MAX TNT and Pipeline
devices, several preparatory steps must be made.  These steps are outlined in
checklist form below.  Specific details follow.

q  Update Ascend device software as needed
See “Device Software Requirements” on page 72 for details on what
software versions are required.

q  Configure SNMP Trap destinations to send Traps to NavisAccess.
See "Configuring SNMP Trap destinations for the MAX and Pipeline" on
page 73 and "Configuring SNMP Trap destinations for the MAX TNT" on
page 80.

q  Configure device read/write community strings.
See "Setting SNMP community strings for the MAX and Pipeline" on page
75 and "Enabling SNMP, community strings on the MAX TNT" on page
82.

q  Enable the Call Logging feature on the MAX and MAX TNT.
See "Enabling Call Logging on the MAX" on page 76 and "Enabling Call
Logging on the MAX TNT" on page 84.

q  Configure SNMP security
See "Configuring SNMP Security on the MAX and Pipeline" on page 78
and  "Enabling SNMP, community strings on the MAX TNT" on page 82.

q  To use the NavisAccess software option, the proper hash codes must be
installed on the device.
See "Installing the Hash Codes" on page 87.
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Device Software Requirements

NavisAccess requires certain levels of Ascend device software for full
functionality.  In addition, the NavisAccess Software Option is required for each
Ascend MAX, MAX TNT, Pipeline 220 and GRF device that NavisAccess will
manage.  Pipeline 50, 75, 85 and 130 models include the Software Option at no
additional cost.

The following table lists required device software levels:

Device Software Level

MAX family 6.0 or higher

Pipeline Family 6.0 or higher

MAX TNT 2.0 or higher

GRF 1.4 or higher

About the NavisAccess Software

Each Ascend MAX, MAX TNT, Pipeline 220 and GRF device requires the
NavisAccess Software Option in order to be managed using NavisAccess.  The
Software Option is sold on a per-device basis, based on the specific device.
Contact Ascend Communications for details on purchasing the Software Option.

The Software Option is installed on devices using a hash code mechanism. See
"Installing the Hash Codes" on page 87 for specifics.
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MAX and Pipeline Preparation

Configuring SNMP Trap destinations for the MAX and Pipeline
The Ascend MAX and Pipeline products send alarm messages in the form of
SNMP Traps. These Traps are sent to a management station (such as
NavisAccess) for logging and interpretation.  If there is an existing Management
Station in your network, the devices may be set up to pass all Traps to it.
Contact the network administrator for this information.

To configure the MAX/Pipeline Trap destination:

1. Attach to the MAX/Pipeline via Telnet or through the console port.

2. Log in with write access.

3. Open the Ethernet menu.

4. Open the SNMP Traps menu.

5. Press [Enter] to open a profile.

6. Assign a name to the profile. For example:

Name=Navis_Machine

The name can be up to 31 characters. It is typically set to the destination of
the Traps (for example, the machine running NavisAccess).
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7. Turn on traps for alarm events, port state changes and security events.

Alarm=Yes
Port=Yes
Security=Yes

8. Enter the SNMP community string for the MAX or Pipeline.  For example:

Comm=secret_string

The entered string must match the SNMP read/write or read “community
name,” which becomes a password sent to the SNMP management station
when an SNMP trap event occurs. It authenticates the sender who is
identified by the source IP address. See “Setting SNMP community
strings” below.

NOTE: To turn off SNMP traps, delete the value for the Comm parameter
and set the next parameter (Dest) to 0.0.0.0.

9. Specify the IP address of a NavisAccess machine. If you are using multiple
NavisAccess consoles logging in to a common server, you can specify any
NavisAccess machine.  Information will be shared across all NavisAccess
stations via the NavisAccess common event system.   For example:

Dest=10.1.2.3/24

Dest establishes the destination address of the trap-status report. Use IP
dotted decimal format. Its default value is 0.0.0.0.

NOTE: To turn off SNMP traps, set Dest=0.0.0.0 and delete the value for
Comm.

10. Save and close the SNMP Traps Profile.
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Setting SNMP community strings for the MAX and Pipeline
SNMP validates each message with a password-like mechanism called a
Community Name.  There are two communities defined on the MAX and
Pipeline families:

n Read Comm
Enables an SNMP manager to perform read commands (GET and GET
NEXT) to request specific information.  The default Read Comm string is
public.

n R/W Comm
Enables an SNMP manager to perform both read and write commands (GET,
GET NEXT, and SET), which means the application can access management
information, set alarm thresholds, and change some settings on the devices.
The default R/W Comm string is write.

If there is an existing management station on your network, the community
names may have been changed from the default values.  Contact the network
administrator for this information.

NOTE:  The read and write Community Names used by NavisAccess must
match what is specified by (on) the device.  Otherwise, communication cannot be
established with the device.

SECURITY NOTE:  There is no way to turn off SNMP write, so you must
change the default read-write string to secure the unit against unauthorized
SNMP access.

To configure the MAX and Pipeline community names:

1. Attach to the MAX/Pipeline via Telnet or through the console port.

2. Log in with write access.

3. Open the Ethernet menu.

4. Open the Mod Config submenu.

5. Open the SNMP Options submenu.

6. Enter up to 16 characters for the Read Comm parameter.  For example:
Read Comm=secret_string

7. Enter up to 16 characters for the R/W Comm parameter.  For example:

R/W Comm=unique_string
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8. Save and close the Ethernet profile.

Enabling Call Logging on the MAX
In order for the Access Watch application to receive data from the MAX , the
Call Logging feature must be enabled and set to send data to the NavisAccess
workstation(s).  Up to three IP addresses can be configured.

NOTE: If you are using multiple NavisAccess consoles logging in to a common
server, you can specify any NavisAccess machine(s).  Information will be shared
across all NavisAccess stations via the NavisAccess common event system.

To configure Call Logging for use with Access Watch:

1. Attach to the MAX via Telnet or through the console port.

2. Log in with write access.

3. Open the Ethernet menu.

4. Open the Mod Config menu.

5. Open the Call Logging menu.  (You may need to scroll down the menu list
to see this entry.)

6. Set the Call Log field to Yes. To do so, move the cursor to the field and
press [Enter].

7. Enter up to three Host IP addresses.  These are NavisAccess machines to
which Call Logging will send information.  For example:

Host #1 = 10.1.2.3
Host #2 = 10.1.2.4
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Host #3 = 10.1.30.10

Each Host #n parameter can specify the IP address of one NavisAccess
server or workstation. The MAX first tries to connect to machine #1 for
call-logging. If it receives no response, it tries to connect to machine #2. If
it receives no response from machine #2, it tries machine #3. If the MAX
connects to a NavisAccess machine other than machine #1, it continues to
use that machine until it fails to service requests, even if the first server has
come online again.

NOTE: If you are using multiple NavisAccess workstations logging in to a
common server, you can specify any NavisAccess machine(s).  Information
will be shared across all NavisAccess stations via the common event
system.

8. If necessary, change the Dst Port value.  This is the destination port
through which the device will send information.  The default value of 1646
is recommended.

9. Set the Call Log Timeout period from 1 to 60 seconds.

The device sends a request to the first host on the list of hosts specified (see
step 7) and waits for a response from the server for the number of seconds
specified in the Call Log Timeout parameter. If the device does not receive
a response within that time, it sends a second request for authentication to
the same server and waits for the same amount of time. If the device does
not receive a response within the specified time-out, it sends a request to
the next host on the list and repeats the process.

10. Enter a Call Logging Key (up to 20 characters). The Key is used to provide
NavisAccess with access to the device.  The same Key entered on the
device must also be entered in NavisAccess.  This is similar in function to
the community string, but not the same.

A default Call Logging Key can be entered in NavisAccess using the
Default Secret field on the Access Watch Configuration tab found under
Config > System Options.

To enter a Key different from the default, open the device Boxmap, right-
click on the Configuration icon and choose Configuration.  Enter the new
key in the Call Logging Secret field.  (For details on the Boxmap, see the
NavisAccess online help or User Guide.)

11. The Acct-ID Base parameter determines if data is sent in Base 10
(decimal) or Base 16 (hexadecimal) format.  This value must be set to 10
for Call Logging to work properly.
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12. Set a Reset Timeout period, from 0 to 86400 seconds.  (86400 seconds = 1
day.)

13. Save and close the Call Logging profile.

Configuring SNMP Security on the MAX and Pipeline
The SNMP Security feature on the MAX and Pipeline restricts device access to
only those management stations specifically entered on the device.  If the
Security feature is currently enabled on your devices, you need to update the
settings to include the NavisAccess station.

You can list up to five IP hosts that can access the MIB read-write access, and
up to five hosts that can read traps and other information.  Following are details
about specifying which hosts can access the MIB.

To configure SNMP manager access on the MAX and Pipeline:

1. Attach to the MAX or Pipeline via Telnet or through the console port.

2. Log in with write access.

3. Open the Ethernet menu.

4. Open the Mod Config submenu.

5. Open the SNMP Options submenu.

6. Set the Security parameter to Yes.

Security=Yes

This parameter specifies that the device compare the source IP address of
packets containing SNMP commands against a list of qualified IP
addresses. The unit checks the version and community strings before
making source IP address comparisons. (The Security parameter does not
affect those checks.)

If Security is set to No, you do not need to enter the NavisAccess machine
address.  We do not recommend setting Security to No.

7. Specify the IP addresses of hosts that will have SNMP read permission.
The NavisAccess station must be included for NavisAccess to manage the
device.  For example:

RD Mgr1=10.1.2.3
RD Mgr2=10.1.2.4
RD Mgr3=10.1.2.5



Using Ascend devices

NavisAccess Getting Started                                                                                                       79

RD Mgr4=10.1.2.6
RD Mgr5=10.1.2.7

If the Security parameter is set to Yes, only SNMP managers at those IP
addresses will be allowed to execute the SNMP GET and GET-NEXT
commands.

8. Specify the IP addresses of hosts that will have SNMP write permission.
For example:

WR Mgr1=10.1.2.3
WR Mgr2=10.1.2.4
WR Mgr3=10.1.2.5
WR Mgr4=10.1.2.6
WR Mgr5=10.1.2.7
If the Security parameter is set to Yes, only SNMP managers at those IP
addresses will be allowed to execute the SNMP SET command.

9. Save and close the Ethernet profile.
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MAX TNT Preparation

Configuring SNMP Trap destinations for the MAX TNT
The Ascend MAX TNT sends messages in the form of SNMP Traps. These
Traps are sent to a management station (such as NavisAccess) for logging and
interpretation.  If there is an existing Management Station in your network, the
devices may be set up to pass all Traps to it.  Contact the network administrator
for this information.

To configure the MAX TNT Trap destination:

1. Attach to the MAX TNT via Telnet or through the console port.

2. Log in with write access.

3. At the command prompt, enter:

new trap

This will return a TRAP/" " read message and a new command prompt.

4. At the command prompt, enter:

list

This will return the following parameter list:

host-name* = “ ”
community-name = “ ”
host-address = 0.0.0.0
alarm-enabled = yes
security-enabled = no
port-enabled = no

5. Enter a host-name (up to 16 characters), as follows:

set host-name = my_host_name

The host-name specifies the hostname of the NavisAccess station. This is
the host to which the MAX TNT will send SNMP traps.  If the host-address
field contains an IP address, the specified name is not used to actually
locate the host.
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6. Enter a community-name (up to 31 characters), as follows:

set community-name = my_community-name

This specifies the SNMP community name associated with the SNMP PDU
(Protocol Data Units). The string you specify becomes a password that the
MAX TNT sends to NavisAccess when an SNMP trap event occurs. The
password authenticates the sender identified by the host address.

7. Enter an IP address for the host-address.  For example:

set host-address = 10.2.3.4

The host-address is the same address as that of the NavisAccess station.

NOTE: If you are using multiple NavisAccess consoles logging in to a
common server, you can specify any NavisAccess machine(s).  Information
will be shared across all NavisAccess stations via the NavisAccess
common event system.

8. Enable all three classes of Traps.

set alarm-enabled = yes
set security-enabled = yes
set port-enabled = yes

9. Finish the configuration by writing the new parameters to the device, as
follows:

write

This will be followed by a “TRAP/host-name written” message.
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Enabling SNMP, community strings on the MAX TNT
The SNMP profile contains SNMP-readable information related to the MAX
TNT and its SNMP security. There are two levels of security: community
strings, which must be known by NavisAccess to access the box, and address
security, which excludes SNMP access unless it is initiated from a specified IP
address.

To enable SNMP and set security on the MAX TNT:

1. Attach to the MAX TNT via Telnet or through the console port.

2. Log in with write access.

3. At the command prompt, enter:

read snmp

This will return a “SNMP read” message, and a new command prompt.

4. At the command prompt, enter:

list

This will return the following parameter list:

enabled = no
read-community = public
read-write-community = write
enforce-address-security = no
read-access-hosts = [ 0.0.0.0 0.0.0.0 0.0.0.0
0.0.0.0 0.0.0.0 ]
write-access-hosts = [ 0.0.0.0 0.0.0.0 0.0.0.0
0.0.0.0 0.0.0.0 ]
contact = " "
location = " "

5. Set the enabled parameter to yes as follows.

set enabled = yes

If the enabled parameter in the SNMP profile is set to No (the default), the
MAX TNT cannot be accessed by NavisAccess.
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6. If necessary, set new read-community and read-write-community strings
(up to 32 characters) as follows:

set read-community = secret_string
set read-write-community = unique_string

The read-community string permits read access to the MAX TNT and the
read-write string permits read/write access.

NOTE:  The read and write Community Names used by NavisAccess must
match what is specified on the MAX TNT.  Otherwise, communication
cannot be established with the device.

7. Set the enforce-address-security parameter to yes, as follows:

set enforce-address-security = yes

If the enforce-address-security parameter is set to No (its default value),
any SNMP manager that presents the right community name will be
allowed access. If it is set to Yes, the MAX TNT checks the source IP
address of the SNMP manager and allows access only to those IP addresses
listed in the read-access-host and write-access-host arrays. Each array can
include up to five host addresses.

8. Set IP addresses for up to five read-access-hosts.  For example:

set read-access-hosts 1 = 10.2.3.4
set read-access-hosts 2 = 10.2.3.5
set read-access-hosts 3 = 10.2.3.6
set read-access-hosts 4 = 10.2.50.123
set read-access-hosts 5 = 10.2.50.124

When this parameter is set, only NavisAccess stations logging in from the
set IP addresses will be granted read-access to the MAX TNT.

9. Set IP addresses for up to five write-access hosts. For example:

set write-access-hosts 1 = 10.2.3.4
set write-access-hosts 2 = 10.2.3.5
set write-access-hosts 3 = 10.2.3.6
set write-access-hosts 4 = 10.2.50.123
set write-access-hosts 5 = 10.2.50.124

When this parameter is set, only NavisAccess stations logging in from the
set IP addresses will be granted write-access to the MAX TNT.

10. It is recommended that you set the contact and location parameters with the
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name and location of the person to contact if there is a problem with the
unit (up to 84 characters).  For example:

set contact = Mary Smith
set location = Green Bay office, 555-1212

11. Finish the configuration by writing the new parameters to the device, as
follows:

write

This will be followed by an “SNMP written” message.

Enabling Call Logging on the MAX TNT
In order for the Access Watch application to receive data from the MAX TNT,
the Call Logging feature must be enabled and set to send data to the NavisAccess
workstation(s).  Up to three IP addresses can be configured.

NOTE: If you are using multiple NavisAccess consoles logging in to a common
server, you can specify any NavisAccess machine(s).  Information will be shared
across all NavisAccess stations via the common event system.

To configure Call Logging for use with Access Watch:

1. Attach to the MAX TNT via Telnet or through the console port.

2. Log in with write access

3. At the command prompt, enter:

read call-logging

This will return an "CALL-LOGGING read" message, and a new command
prompt.

4. At the command prompt, enter:

list

This will return a parameter list similar to the following.

call-log-enable = no
call-log-host-1 = 0.0.0.0
call-log-host-2 = 0.0.0.0
call-log-host-3 = 0.0.0.0
call-log-port = 0
call-log-key = ""
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call-log-timeout = 0
call-log-id-base = acct-base-10
call-log-reset-time = 0
call-log-stop-only = yes
call-log-limit-retry = 0

5. Set the call-log enable parameter to “yes” as follows:

set call-log-enable = yes

6. The other parameters may or may not need to be set using the same syntax:

set command-name = parameter-value

Parameters are explained below, and shown with default values in place:

call-log-host-1 = 0.0.0.0
call-log-host-2 = 0.0.0.0
call-log-host-3 = 0.0.0.0
This points call logging information to the NavisAccess console (server,
workstation or standalone).  Set this parameter to the IP address of a
NavisAccess console.

Each call-log-host-n parameter can specify the IP address of one
NavisAccess server or workstation. The MAX TNT first tries to connect to
machine #1 for call-logging. If it receives no response, it tries to connect to
machine #2. If it receives no response from machine #2, it tries machine
#3. If the MAX TNT connects to a NavisAccess machine other than
machine #1, it continues to use that machine until it fails to service
requests, even if the first server has come online again.

NOTE: If you are using multiple NavisAccess consoles logging in to a
common server, you can specify any NavisAccess machine(s).  Information
will be shared across all NavisAccess stations via the common event
system.

call-log-port =0
The call-log-port parameter specifies the UDP destination port to use for
call-logging requests. The default zero indicates any UDP port. If you
specify a different number, the call log host (NavisAccess) must specify the
same port number (the numbers must match).

By default, NavisAccess uses port 1646.  This is the recommended setting
on the TNT.

call-log-key = " "
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Enter a Call Logging key.  The key is used to provide NavisAccess with
access to the TNT. The same Key entered on the device must also be
entered in NavisAccess.  This is similar in function to the community
string, but not the same.

A default Call Logging Key can be entered in NavisAccess using the
Default Secret field on the Access Watch Configuration tab found under
Config > System Options.

To enter a Key different from the default, open the device Boxmap, right-
click on the Configuration icon and choose Configuration.  Enter the new
key in the Call Logging Secret field.

call-log-timeout =0
The number of seconds the MAX TNT will wait for a response to a call-
logging request.  This value can be set from 1 to 10.  0 is the default, which
disables the timer.

call-log-id-base = acct-base-10
Specifies if data is sent in Base 10 (decimal) or Base-16 (hexadecimal)
format.  Parameter settings are acct-base-10 and acct-base-16, respectively.
This value must be set to acct-base-10 for NavisAccess to function
properly.

call-log-reset-time = 0
Indicates the number of seconds that must elapse before the MAX TNT
returns to using the primary call log host (call-log-host-1). The default zero
disables the reset to the primary call log host.

call-log-stop-only = yes
The MAX TNT typically sends Start and Stop packets to the host to record
connections. Authentication is required to send a Start packet. There are
situations that the MAX TNT will send a Stop packet without having sent a
Start packet. These Stop packets have no user name. The call-log-stop-
only parameter specifies whether the MAX TNT should send an Stop
packet with no user name. The default value is Yes. You can set this
parameter to No to prevent the unit from sending Stop packets with no user
name.

call-log-limit-retry = 0
If the NavisAccess station does not acknowledge a Start or Stop packet within

the number of seconds in call-log-timeout, the MAX TNT tries again, re-
sending the packet until the server responds or the packet is dropped
because the queue is full. The call-log-limit-retry parameter sets the
maximum number of retries for these packets.  A value of 0 (the default)
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indicates an unlimited number of retries.  There is minimum of 1 retry. For
example, setting the parameter to 10 retries would make a total of 11
attempts: the original attempt plus 10 retries.

8. Make the necessary setting changes to the parameters discussed in Step 6.
Following is a sample setting of Call Logging parameters.  Comments are
shown in brackets [   ].

Set call-log-enable = yes [Must be set or Call Logging will
not work]

Set call-log-host-1 = 150.10.10.10 [NavisAccess console]
Set call-log-host-2 = 150.10.10.12 [Alternate NavisAccess console]
Set call-log-port = 1646

set call-log-key = mysecretstring [Must match string entered via
NavisAccess.]

set call-log-timeout = 2

set call-log-id-base = acct-base-10 [This parameter must be set as
shown.]

9. Finish the configuration by writing the new parameters to the device, as
follows:

write
This will be followed by a "CALL-LOGGING written" message.

Installing the Hash Codes
To use NavisAccess on Ascend devices, the NavisAccess Software Option must
be purchased for each Ascend device. (MAX, MAX TNT, Pipeline 220 and
GRF.  Pipeline 50, 75, 85 and 130 models include the Software Option.)

To enable the Option on the MAX, MAX TNT and Pipeline, a hash code must
be entered on the device.

To purchase the Option and receive a hash code, contact your Ascend
Communications sales representative.  A brief outline of the procedure is
provided below.

Entering the hash code

1. A hash code is received from Ascend Communications.  The code consists
of several lines of text.

2. Connect to the device via Telnet or console.
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3. Enter device debug mode.

This brings up the > prompt.

4. Type the hash code and hit [Return].  Alternately, if you have the hash code
in electronic format, cut and paste the codes onto the screen.

5. A confirmation message will display.

6. Reset the device to enable the Software Option.

Preparation Checklist: Ascend GRF

To use NavisAccess with the Ascend GRF, the following must be done:

n SNMP community strings on the device must match those entered in
NavisAccess.

n The GRF must be configured to send Traps to the NavisAccess server or
workstation.

n The NavisAccess Software Option must be purchased for the device.

Please consult the GRF documentation for instructions.
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7 The NavisAccess QuickTour 5

About the QuickTour

The NavisAccess QuickTour is a short walk through several NavisAccess
features, with an emphasis on management of the access layer.  This is not a
comprehensive tour of the NavisAccess product.  Many more applications are
available within NavisAccess.  Consult the online help or NavisAccess User
Guide for details.

Similarly, many of the applications touched on in the QuickTour are not
explained in detail.  Consult the online help or User Guide for specifics, such as
definitions of all fields on a screen.

Before you Start

Before the QuickTour begins, the following should be in place:

n NavisAccess should be installed, and you should have Administrator-level
rights to the software.

n You should be familiar with the IP addresses of a few network devices.

n You should know both the read and write community strings for at least
several devices on your network.  More is better.

n It is very helpful to activate Call Logging on at least some Ascend devices.

HP OpenView Users

If you are using NavisAccess on HP OpenView, some of the steps in the
QuickTour will be different.  OpenView-specific steps and information are
highlighted in the QuickTour using the OpenView icon, as seen at left.
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The Tour Starts Here
The NavisAccess QuickTour consists of several phases.

n PHASE 1- Startup and Discovery
How to start NavisAccess and discover network devices.

n PHASE 2 - The Group Wizard and Boxmap
How to configure devices into groups, access applications and view device
backpanels.

n PHASE 3 - Access Watch: Remote Access at a Glance
Your entire access network on one screen.

n PHASE 4 - The Internet Map
A visual, configurable depiction of the network.

n PHASE 5 - Performance Monitoring
Multiple tools to monitor network performance.

n PHASE 6 - Frame Relay
Evaluating Frame Relay performance based on CIR.

n PHASE 7 - Pinpointing Network Bottlenecks
A quick way to find out where problems are.

n PHASE 8 - Configuration Management
Making configuration easier and error-free.

n PHASE 9 - Other Features
A quick overview of the many other powerful features found in NavisAccess.

The QuickTour assumes that you have not yet discovered any devices and have
an empty database.  If you have already started NavisAccess and discovered
some devices, you can proceed to PHASE 2.
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PHASE 1 - Startup and Discovery

NOTE: For the purposes of the QuickTour, many dialog box fields will not be
explained.  We will only use those fields needed for the Tour.  Please click the
online help button for more details on a particular screen.

1. NavisAccess must first be started on the server. For details, see "Starting
NavisAccess:Solaris standalone" on page 24 or "Starting NavisAccess:HP
OpenView" on page 50.

2. To start the console application, open a terminal session and make sure you
are in the NavisAccess installation directory.   Enter

SRM
to start the console.

HP OpenView STEP:

From the OpenView Node Manager menu bar, select NavisAccess >
Start NavisAccess.

3. The NavisAccess login screen appears.  If this is the first time you are
logging in to the software, enter Admin for both user name and password.
This can be changed later.

4. When NavisAccess starts, the Group Wizard screen will appear with no
devices.  There are two ways to add devices to the Group Wizard: manually
and with automatic discovery.  We will do both.

HP OpenView NOTE:

The Group Wizard will not automatically open in OpenView.  To open the
Group Wizard, select NavisAccess > Devices > Group Wizard.
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Manual discovery

HP OpenView NOTE:

NavisAccess on OpenView uses the OpenView database and does not do
its own discovery.  See the OpenView note at the end of Phase 1 for details.

5. First, we will add a known device to the Group Wizard.  From the main
menu bar, select File >New Device.  The New Device screen opens.

6. Enter the IP address and community string for a device, and click OK. The
device will appear in the Group Wizard.  (The device may temporarily
have a yellow "X" across it while NavisAccess scans the device and
identifies it.)

Devices are identified by vendor-specific icons.  Ascend device icons also
identify the type of device (MAX, Pipeline, etc.).  Discover several more
devices this way if you wish.

Automatic discovery

7. Manual discovery is acceptable for a few devices, but it is insufficient for a
large network.  Fortunately, the NavisAccess Explorer can cover even the
largest networks.

Before starting Explorer, we must set the default community strings
NavisAccess will use to access devices.  "Public" is already configured in
the system.  If you need to enter other strings, open the System Options
screen by selecting Config > System Options from the main menu bar.
Then click the CommStr tab.  Enter a write community string and one or
more read strings.  Click [New] to enter read strings.  The default write
string is “write”.

8. Close the Configuration window.  Open the Explorer by selecting Tools >
Explorer from the main menu.



QuickTour

NavisAccess Getting Started                                                                                                   93

In the Seed Router field, enter a device IP address.  The Seed Router is the
first device NavisAccess will contact as it explores the network.  You may
choose a device that is already discovered or one that has not yet been
discovered.

9. Click [OK] to start discovery.  You will soon see devices appearing one at
a time in the Group Wizard window.  Explorer will attempt to traverse the
entire network, and this could take quite some time in a large network.
Once you have discovered a dozen or so devices, you may want to stop the
Explorer to continue the QuickTour.   (You can continue the QuickTour
while Explorer is still running, but there will be some slowdown in
performance as Explorer is continually writing information to the
database.)

Stop Explorer simply by closing the Explorer window.

When you have enough devices discovered, go on to PHASE 2.  If you
wish to test remote access management, make sure you have several
Ascend access devices discovered.
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Discovery on OpenView
NavisAccess utilizes the OpenView discovery and device database.  If you
have not already discovered devices using OpenView, please consult your
OpenView documentation and discover your network.

When OpenView discovery is complete, devices are scanned by
NavisAccess and entered into the NavisAccess database.

To enter devices in the NavisAccess database, select NavisAccess >
Devices > Discover to open the Discover Devices window.

Click the [Scan DB] button to load devices from the OpenView database
into the Discover Devices window.  Select the devices you wish to enter
into the NavisAccess database.  Click the [Discover] button to enter the
devices.

All Discovered devices will display the NavisAccess icon on the
OpenView map, as in this example:
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PHASE 2 - The Group Wizard and Boxmap

NOTE: For maximum benefit in Phase 2, you should have Group Wizard
populated by a dozen or so devices.

The Group Wizard provides access to a great deal of NavisAccess functionality,
including the unique ability to combine devices into logical groups.  If you right-
click on a device icon you will see a large number of menu choices (they will
vary based on the type of device).  Let's begin to look at some of these.

1. First, let's customize Group Wizard to look the way we want it to.  If you
right-click on a blank area of the right-side window, you will see a number
of viewing options (similar to those in the Windows Explorer).  Try out
several options to find what you like.  Here is a sample Group Wizard
showing multi-vendor devices and several groups.

2. Next, right-click on a device icon and select Boxmap.  The Boxmap is the
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central location for most device-specific applications.

When the Boxmap opens, you may see one of two things.  If the device is
an Ascend device (MAX, MAX TNT, Pipeline, GRF) or certain Cisco
routers, you will see an illustration of the device backpanel.  If the device
contains slot cards, they will appear in the illustration as they are scanned
and identified.  This view is referred to as the Physical View.

For other devices, you will see the Application View, which is a collection
of icons, each of which provides access to related applications.  For Ascend
and Cisco devices, you can switch from the Physical View to the
Application View by double-clicking in the Boxmap anywhere but on a
device interface.

HP OpenView NOTE:

You can also access the Boxmap by highlighting a device on the OpenView
map and selecting NavisAccess > Devices > Boxmap from the menu bar.

About the Physical View

The Physical View is an accurate depiction of the device as it exists on the
network.  The slot cards and interfaces appear in the appropriate place, and
a red or green line indicates if they are up or down.  Tool-tips identify
items on the illustration.  By right-clicking on an interface,  you can access
several applications specific to the interface, such as Interface Utilization.

If you right-click anywhere but on an interface, you will access a full menu
of applications for that device.  As the applications become familiar to you,
this will be a fast and easy way to launch them.

About the Application View

The Application View provides access to the same applications as the
Physical View, but it displays them in a different fashion.  Each category of
application is given an icon, and the right-click menu from the icon
launches them.

We will look at some of these applications as the QuickTour continues.
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Creating device groups

3. Now it's time to create groups.  Device grouping provides a critical
management advantage: the ability to consolidate a large, sprawling access
network into manageable units.

In the left-pane of the Group Wizard, right-click the Universe folder and
select New Group.  A new folder will appear with the default name "New
Group."  Type a new name for the group.  Let's name this folder Group 1.
Create another folder and name it Group 2.

Then, click and hold a device icon in the right-pane and drag it into folder
Group 1.  Do the same with another device.  You have just grouped two
devices. As easy as that.

Continue to add devices to your two groups.  The same device can be
added to both groups.  You can drag multiple devices by using standard
Windows [Ctrl] and [Shift] selection functions.  There are also many
options for copying groups, moving them, linking them and so on.   See the
User Guide or online help for details.

Group Wizard also allows for sub-groups.  For example, if you right-click
the Group 1 folder and choose New Group, you can create a sub-group
within Group 1.  Try it.  Create as many sub-groups as you wish.  The same
devices can be added to any groups or sub-groups, even within the same
tree structure.

4. You can group any devices in the Group Wizard, but there are special
applications associated with access devices (MAX, MAX TNT, Pipeline).
Create at least one group that consists only of access devices.  Ideally,
create a top level group with two sub-groups, and populate the sub-groups
with access devices.  It will be similar to this:
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Groups of routers are useful for tasks such as scheduling background data
gathering.  For now, let's look at one of the most powerful features of
NavisAccess -- Access Watch.

PHASE 3 - Access Watch: Remote Access at a Glance

NOTE: For Phase 3, you should have created at least one group consisting of
Ascend access devices. For Access Watch to report data, the Call Logging
parameter must be configured for MAX and MAX TNT devices.  This parameter
requires MAX software version 6.0 or higher and/or MAX TNT software 2.0 or
higher.  See Chapter 4 for details.

Access Watch lets you monitor your entire access network from one screen.  The
powerful grouping ability of NavisAccess not only consolidates many devices
into a single view, but it provides aggregate performance data for the grouped
devices.

1. If you have not yet done so, create a group consisting of only Ascend
access devices (MAX, MAX TNT).  Ideally, the group should have two
sub-groups, each with access devices (for this illustration, you can use the
same devices in each group).  For full Access Watch functionality, the
devices must be properly configured with the Call Logging parameter set
(see Chapter 4 for details).

For our illustration, we have created a group called National WAN, with
two subgroups:  East Coast WAN and West Coast WAN.

2. In the Group Wizard, right-click on the top-level group and select Access
Watch.  The Access Watch top level screen opens.
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Within seconds, aggregate call statistics begin appearing on the screen.
Groups statistics are shown in bold type, single-devices are in regular type.

It is vital to realize that any displayed group information is consolidated
data from all devices in the group.  For example, if the Currently Running
Sessions field for a group shows 150, that means there is a total of 150
sessions running on all devices in the group.

Only NavisAccess can manage your access services in this fashion,
providing you with an overall understanding of the entire access layer.

As you can see, the Access Watch screen provides an enormous amount of
information: number of sessions and calls, dropped calls, call duration,
modem and channel utilization and availability.  It also monitors threshold
levels and will generate warnings if thresholds are breached.

Want to see what the individual devices in a group are doing?  Just click on
the group name in the first column and a second screen will launch which
will show the same statistics on a device-by-device basis.

But this screen is only the beginning.  There are many additional screens
you can drill down into for details about the statistics and other
functionality.  Let's look at some of them.

3. The Currently Running Sessions column shows the number of sessions.
Clicking on the cell opens the Active Sessions window, which breaks out
the data into individual sessions.
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Here we see exactly who is connected, how long they've been connected,
the connection rate and more.  Not only that, but we can disconnect any
caller on the screen.  Just right-click on a row to bring up the Disconnect
User Name menu.  When NavisAccess asks if you are sure you want to
disconnect this user, answer [Yes] and the call will be dropped.

4. Go back to the main screen and click the Calls cell.  This opens the Call
Monitor window.

The Call Monitor displays the total number of ongoing calls, and breaks
them up by type.  It also shows the High number, which is the highest
number of active calls at any point in the monitoring period.

5. Among the most valuable tools for trouble-shooting is the Modem Pools
window.  Click in the % Modem Utilization/Availability cell to open the
window.  There are two examples below, one showing Modem Pools at a
group level, the other at a device-level.  Just double-click on the group
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level to open the device level window.

The Modem Pools screen lets you see exactly which devices have suspect,
disabled or dead modems, allowing you to zero in on problems.
Double-clicking in any cell will bring up the individual Modem Pool
window, which provides details on all the modems in a particular state.
For example, if you clicked in the Available cell, you would see a window
similar to this:
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This shows where the available modems are, based on slot number and port
number, how many times the modems were used (Used Count) and how
many times they failed (Bad Count).

6. Further modem details can be accessed through the Slot Modem Table.
Right-click on a device icon in the Group Wizard and select Access Apps
> Slot Modem Table.

The Slot Modem Table drills-down to the individual modem level,
allowing you to view status at the smallest level of granularity.  In addition,
you can enable and disable modems from this window by right-clicking on
a modem and opening the Modem Configuration dialog.
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7. The % Channel Utilization/Availability cell also offers drill-down into
channel specifics.  Click in the cell to open the Wan Line Table window.

This window gives channel details for each interface.  You can change the
state of a channel by right-clicking on it to bring up the Digital Line
Configuration dialog.

You can use this to enable a line (trunk), quiesce it or disable it.

Still another level of drill-down is available by double-clicking on a row to
access the WAN Line Channel Table.
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This breaks out interface data on a per-channel basis, allowing you to see
exactly what is happening right down to the channel level.

As you can see, Access Watch gathers all the information you need and
delivers it right to your finger-tips.
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PHASE 4 -  The Internet Map

The Internet Map provides a graphical depiction of the entire network, including
network devices and connection types.  To launch the Internet Map, select File >
Internet Map from the main menu bar.

HP OpenView NOTE:

The NavisAccess map is available in addition to the OpenView map, and it
provides many extra features.  To access the map in OpenView, select
NavisAccess > Devices > Internet Map from the OpenView map's menu
bar.

The map contains device icons, which represent specific devices, and link icons,
which represent connection types (Ethernet, Frame Relay, etc.)  Among the
capabilities provided by the map are:
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n Launching of device-specific applications

n Launching of link/connection-specific applications

n Launching of protocol/service-specific applications

n Grouping of map icons into logical entities (LAN, POP, Corporate Office,
etc.)

n Manually creating links between devices

n Drill-down into smaller submaps, circuit maps and segment maps

n Reporting of device alarms

n Color-coding of network link status (up, down, degraded)

n Filtering and finding tools

Consult the online help or User Guide for detailed instructions on using the
Internet Map.  For now, just take a few minutes to explore the map by clicking
on icons, moving them around, trying some of the toolbar buttons, viewing right-
click menus, etc.  You will find that most map functionality is easy and intuitive,
and after only a short time you will be an expert map user.
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PHASE 5 - Performance Monitoring

NavisAccess provides a wealth of tools to monitor network performance.  We
have already seen performance tools for access devices in Phase 3.   This section
will highlight a few more such tools, but by no means all of them.

Link Utilization

1. Open the Internet Map and choose a device you'd like to monitor.  Double-
click on a link line close to the device. 

2. The Applet Parameters box will display, with a default setting of a 60
second polling interval and a Line Style graph.  Click [OK].

3. The Utilization Graph for the interface on the device which is responsible
for that link displays.  It will be similar to this:
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Top 10 Utilization

4. So far we have looked at utilization on a single device and a single
interface.  Unfortunately, rarely in life is troubleshooting so easy.  In most
cases you’ll  need to look at the subnet or device as a whole.  The Top 10
Utilizations application is designed to do this.  To see how it works on a
single device, follow the steps below.

5. Open the Boxmap and double-click the Top 10 Utilization icon.

6. Click [OK] for the Applet Parameters window.  The Top 10 Utilizations
window displays.

The Blue bar indicates Average utilization.   The Red bar indicates
Maximum utilization.  The Green bar indicates Current utilization.

This graph displays up to the ten most active interfaces on the device.  If
the device has less than ten interfaces, all of the interfaces on the device
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will be represented in the graph.  Feel free to investigate the Sort and
Config tools for details on how activity is measured.

IP Performance

7. Now let's check performance for the IP Protocol. The IP Performance
applet monitors Input, Forward, Local and Output packet statistics.  To
launch, right-click on the IP icon in the Boxmap and select Performance.

Similar graphs are available for IPX and AppleTalk.

DS1 Status and Statistics

8. We can also get quick access to DS1 (T1 and E1) line status conditions and
statistics using the DS1 applet.  Right-click on the DS1 icon and select
DS1/E1 Configuration (the icon will only appear on devices with a T1 or
E1 connection).  This bring up the DS1 Config table, which lists
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information such as line type, line coding, etc.  You can also view details
such as Errored Seconds, Severely Errored Seconds, etc. by selecting a row
in the Config table and clicking the appropriate toolbar buttons.

PHASE 6 - Frame Relay
NOTE: For Phase 6, you must have Frame Relay running on your network. If
you are running Frame Relay, continue with this phase.  Otherwise, move on to
Phase 7.

1. Open the NavisAccess Internet Map and locate a Frame Relay cloud icon,
such as this one that connects three routers.

If Frame Relay is not running on your network, you will not see this icon.

2. Double-click the icon to open a Circuit Map, which displays the individual
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Frame Relay circuits, such as this:

A Frame Relay circuit is a logical connection between two routers.  Each
circuit contains a DLCI on one router, the path through the carrier network,
and a DLCI on a second router.

3. The next steps involve creating a Virtual Circuit by associating the proper
DLCI# on each router with the Virtual Circuit.  An IP subnet address is
listed under each Frame Relay icon to help you associate it with the correct
DLCI.

4. Double-click a circuit icon that is connecting two devices.  The Virtual
Circuit Link Configuration dialog box displays.
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To top of the dialog displays the name of the device, its parent interface
(Poll IF), its logical interface that you are configuring (Config IF), and its
IP address.

NOTE:  If you are using subinterfacing or virtual ports, you must verify
that the Poll IF field contains the correct information.  The Poll IF Field
should contain the physical interface connected to the Frame Relay
network.

The Stored CIR field gives you access to the Frame Relay CIR Override
feature.  This feature allows you to set the CIR value of a DLCI.  The CIR
value that you set is known as the "Stored CIR" value.

5. Select the DLCI associated with the IP subnet for Device 1 from the list
that appears in the dialog box.  You should check the documentation for the
device to determine the DLCI associated with the IP subnet.

6. Click the Device 2 tab and select a DLCI for that device.

7. Click the Link Name tab.  Enter a descriptive name for the DLCI Link, and
choose the Create Virtual Element option.

8. Click [OK] to close the window.

A Virtual Element will now be available in the Group Wizard.   A Virtual
Element is an icon that represents the Virtual Circuit Link we have just
created.  From this icon you can launch performance-related applications.
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The Virtual Element appears as follows:

The display name will be whatever name you entered in Step 7.

9. Right-click on the Virtual Element icon.  You will see three options:
Configuration, Utilization and Statistics.

Configuration allows you to edit the link you just created by changing the
name, changing DLCIs, etc.

10. Choose the Utilization option.  This will open the Frame Relay Virtual
Circuit Link Utilization graph:

The graph displays the input and output utilization for both sides of the
configured Link.
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11. Right-click the Virtual Element again and choose Statistics.  The Frame
Relay Virtual Circuit Link Statistics window displays:

The upper panes contain information on the devices in the Virtual Circuit
Link.  The Stored CIR value indicated in the top pane will be the ifSpeed
value for the CIR if both the agent CIR (CIR MIB variable supplied by the
manufacturer of the device) and stored CIR values are zero.

The lower pane contains a wealth of performance information (see the
online help for field specifics).

The Bytes In on one side of the Virtual Circuit should match the  Bytes Out
on the other side, and the Frame In on one side of the Virtual Circuit
should match the Frame Out on the other side.  The % Byte Discards and
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% Frame Discards inform you of the percent of data that your carrier is
dropping.  A high percentage of discards can indicate the need to increase
the bandwidth for this circuit.

PHASE 7 - Pinpointing Network Bottlenecks

Think you may have a bottleneck, or just want to check on the data flow between
two devices?  The PathFinder Tool gives you the information you need in a
matter of seconds.

1. From the File menu, select File > Pathfinder.  The Select Path dialog
opens:

HP OpenView STEP:

To access PathFinder in OpenView, select NavisAccess > Devices >
PathFinder from the OpenView map's menu bar.

2. Using the drop-down boxes, select a Source Device and a Destination
Device.  These represent the start and end points for the network path we
will trace.  For this illustration, select the Round Trip option.

3. Click [OK].  NavisAccess will trace the path between the devices and
graphically portray it:
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From the PathFinder screen, you can easily view the port Utilization and
Error levels -- both in to and out of each device.  The type and bandwidth
of the interfaces used to determine the route are shown, giving you a
concise view of the path between the selected devices.

NavisAccess also gives you the ability to specify which interface on the
Source device should be used as the starting point for determining the path,
and which interface on the Destination device should be used as the ending
point for determining the path.  In addition, NavisAccess makes it easy to
see whether a path is symmetrical or asymmetrical.

4. If you wish to easily run Pathfinder for these two devices in the future,
click the [Create Virtual Element] button to create a Virtual Element in the
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Group Wizard.  From this icon, you can re-launch Pathfinder for these two
devices by just double-clicking.  The Pathfinder Virtual Element icon looks
like this, with user-defined text.

PHASE 8 - Configuration Management

NavisAccess provides many tools to make device configuration faster, easier and
error-free.  We will look at one of these tools and briefly discuss several others.

Configuration File management

Managing device configuration files is an ongoing, labor-intensive task that often
involves time-consuming and error-prone Telnet sessions.  NavisAccess
provides an easy-to-use utility that makes configuration file management easy.

1. From the Boxmap of an Ascend device, right-click on the Configuration
icon and choose Configure Router.

2. The Configure Router applet appears.  The first step is to download the
configuration file currently on the device.

3. Click the [Retrieve Configuration File] button.  In the Get Configuration
File window, click [Download].  This will bring up the Select Download
Mode dialog.  Consult the online help for details on available options.
For now, keep the default value and click [OK].

4. If you have the proper write community string configured, the
configuration file will begin to download.  (To change the write string,
right-click on the same Configuration icon and choose "Configuration".)

The configuration file will appear in the left-pane of the Configure Router
applet.
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5. The next step is to save this file in the NavisAccess database.  This will
become the default configuration file.

To save it, click the [Save] button.  This opens the Save Configuration file
window.
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6. In the Selected File box, enter a name (we suggest DEFAULT for the
default file) and click the Default check box.  Then click [Save New] to
save the file.

This file is now saved as the default configuration file.  There are a number
of uses for this.  You can use this file as a template for creating new
configuration files.  You can use it as a rollback file if and when an
incorrect change to a configuration file causes a problem.  You can use it as
a base file against which a differences operation can be performed.

Let's take a look at that feature.

7. NavisAccess lets you compare two configuration files to quickly see
exactly what is different between the two files.  This is a great way to
immediately identify where a configuration setting may have gone wrong.

Begin by clearing the screen by clicking the [Clear Configuration] button.

8. Next, reopen the config file we just saved.  Click the [Retrieve
Configuration File] button again.  The default file will be highlighted in
red.  Click the file name and then click the [Retrieve] button.  The file will
appear in the left-hand pane.

9. Select any three parameters and change the settings.  We will change the
following:

NAT=No
NATLAN=No
POTS=No

They will all be changed to equal Yes.

10. Make similar changes in your own file, save the file again, and call it
TEST.

11. Clear the screen.

12. Download the file from the device a second time so it appears in the left-
hand window pane.

13. Click the [Perform Differences Operation] button.   Highlight the file
TEST, and click [Retrieve].

The TEST file (in which we made changes) will be compared to the file we
just downloaded.  The differences between the files will be displayed in the
right-hand window pane.  In our example, it would look like this:
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Notice that the three parameters we changed appear in the window, along
with their line numbers and a plus or minus sign.  The signs indicate what
needs to be done to make the two files identical.

A minus sign indicates that you would have to remove those lines from the
file now showing in the left-hand pane.  A plus sign means you need to add
those lines to the file.  In our example, that clearly means changing the No
parameters to Yes.

More configuration tools

This is only one example of what NavisAccess offers.  Among other tools are:

n Scheduled config download and diffing
You can schedule a download to take place on a regular basis.  The
downloaded file will be compared with the Default file, and if there are any
differences an alert will be generated.  This allows you to maintain close
watch on any changes that are being made.

n Configuration uploads
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Using the same utility we just explored, you can easily upload configuration
files.  You can also schedule uploads to take place on one device or across
many devices at the same time.  This means you can update the configuration
files on your entire network with one simple schedule.

n Software uploads
You can also upload device software, either individually or across multiple
devices.

n Multi-vendor support
Configuration tools are available for many different vendor devices.

n System Reset
For Ascend MAX, Pipeline and MAX TNT devices, right-clicking on the
Configuration icon presents a System Reset option, which lets you reset the
box with a simple point-and-click process.

See the online help or NavisAccess User Guide for details on these and still
other configuration utilities.

PHASE 9 - Other Features

Even with all the features we have just touched on, they are only a part of what
NavisAccess has to offer.  Many other features are available.  They are all fully
documented in the online help or NavisAccess User Guide.

Of course, you can always just explore the application on your own, opening
screens and seeing what shows up.  All screens have context-sensitive help
which should answer any questions you have.

Some major features you might want to look for:

n Fault Monitoring
NavisAccess features an extensive system of fault monitoring tools.  Access
devices can be monitored for changes in call rates, modem and channel
utilization thresholds and more.  Routers can be monitored for error levels,
interface up and down status, utilization thresholds and more.

n Extensive Reporting
The NavisAccess reporting tools let you trend your network over days and
weeks.  There are over 40 predefined reports which can be run on single
devices or, more importantly, on groups of devices.  Only through group-
based reports can you get an accurate picture of what happens on your
network over the course of a day or a week.
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n Scheduled Applications
NavisAccess provides an easy-to-use Schedule Wizard that lets you schedule
many different tasks.  Some of the schedules work in conjunction with the
reporting tools to gather data for network performance, interface utilization,
etc.  Other schedules perform specific tasks, such as configuration file
download and diffing, software uploads, password changes, device
discovery, etc.

n MIB Tools
The NavisAccess MIB compiler is a handy tool that lets you quickly browse
a device MIB and check the current values for any MIB variables.  MIB
profiles can be created allowing you one-click access to MIB variables.  The
tools can return data in text, table or even graphical format.

n Additional Performance Tools
In addition to the performance tools covered in the QuickTour, NavisAccess
has other tools for monitoring IP, IPX, AppleTalk, X.25, Bridging, Buffers,
Performance Distribution and more.
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8 Appendix A: Uninstalling Solaris standalone

Uninstalling NavisAccess on Solaris standalone

The following procedure can be used to uninstall NavisAccess from your Solaris
system.  This is only for the standalone version of NavisAccess.

1. Make sure you are using the kourne shell (type ksh at the prompt) and also
make sure that NavisAccess program is closed.

2. Run the following at the command prompt:

stop_all.ksh   [to stop the services]

3. Run the following:

dbstop   [to stop the database engine]

4. Run the following:

/etc/rc0.d/K99windu stop  [to stop all windu services]

Also check if any other windu clients are running. If they are, you must kill
them before you proceed.  One way to do this is as follows:

ps –aef | grep windu_client

Note the process ID of windu_clientd40 and kill it as follows:

kill  -9 <windu_clientd40-pid>

5. Run the following:

unset AutoBahn

6. Delete the following files:

/etc/rc2.d/S99ascendDBeng
/etc/rc2.d/S99windu
/etc/rc0.d/K99ascendDBeng
/etc/rc0.d/K99windu
/etc/init.d/ascendDBeng
/etc/init.d/windu
/etc/dt/config/Xsession.d/ascendNavisAccess

7. Delete the NavisAccess installation directory, for example:
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/export/home/navisaccess

- or -

/opt/navisaccess)

8. If you edited your .profile file to run the .NavisAccessProfile script, you
can re-edit to remove references to running this script.

9. Optional: Re-edit your semaphore changes back to default:

10. Under the file

/etc/system...

Remove the "set" statements you previously entered in.

11. Reboot your system at this time.
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9 Appendix B: License agreement
MINIMUM END USER LICENSE TERMS

License.  The term "Software" includes all Ascend and third party ("Supplier") software
provided to you with this Ascend product, and includes any accompanying documentation (the
"Documentation").  The term "Software" also includes any updates of the Software provided to
you by Ascend at its option.  Subject to the terms of this Agreement, Ascend grants to you, and
you accept, a personal, non-exclusive, and nontransferable (except as set forth below) license to
use the object code version of the Software on a single computer.  The Software is "in use" on a
computer when it is loaded into the temporary memory (i.e. RAM) or installed into the
permanent memory (e.g. hard drive, CD-ROM or other storage device) of that computer, except
that a copy installed on a network server for the sole purpose of distribution to other computers
is not "in use".  If you permanently install the Software on the hard disk or other storage device
of a computer (other than a network server) and you use that computer more than 80% of the
time it is in use, then you may also use the Software on a portable or home computer.  You may
make a reasonable number of copies of the Software and Documentation for backup or archival
purposes only, so long as Ascend's and its licensors copyright notices are reproduced on such
copies.

Limitations on Use.  You may not copy, rent, lease, sell, sublicense, assign, loan, time-share or
otherwise transfer or distribute copies of the Software or Documentation to others, except as set
forth in this agreement.  You may physically transfer the Software from one computer to
another provided that you do not retain any copies of the Software, including any copies stored
on a computer.  You may permanently transfer this license to another user, but only if you
transfer or destroy all copies of the Software and Documentation, and the recipient agrees in
writing to be bound by all of the terms of this agreement.

You agree that you will not decompile, disassemble, or otherwise reverse engineer the
Software, and you will use your best efforts to prevent your employees and contractors from
doing so, except to the extent that such restriction is expressly prohibited by applicable law.
You may not modify, adapt, create a derivative work, merge, or translate the Software or the
Documentation without the prior written consent of Ascend.

Specific Suppliers may be identified in the Documentation.  You agree to any additional terms
and conditions specific to particular Suppliers or Products, as described in the Documentation,
which are incorporated herein by reference.
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Intellectual Property Rights.  You acknowledge that Ascend or its Suppliers retain exclusive
ownership of all copyrights, trademarks, patents and/or other intellectual property rights in the
Software and the Documentation.  You are not granted any rights in the Software or
Documentation other than the license rights expressly set forth above.

Term and Termination.  The term of this license is for the duration of any copyright in the
Software.  This license automatically terminates if you fail to comply with any of the terms and
conditions of this agreement.  You agree that, upon such termination, you will either destroy (or
permanently erase) all copies of the Software and Documentation, or return the original
Software and Documentation to Ascend.  You may terminate this license at any time by
destroying the Software and Documentation and any permitted copies.

Limited Warranty and Limited Remedy.  Ascend warrants to the original end user purchaser
only that the Software as delivered at the time of purchase will substantially conform to the
Documentation, and that the original diskettes and Documentation are free from defects in
material and workmanship under normal use, for a period of ninety (90) days from the original
end user's purchase thereof (the "Limited Warranty Period"), provided the Software is used
with compatible computer hardware and operating systems.  This limited warranty is void if
failure of the Software has resulted from accident, abuse, or misapplication.  Ascend's entire
liability, and your sole and exclusive remedy shall be, at Ascend's option, either to (a) correct
or help you work around or avoid a reproducible Error, (b) replace defective diskettes or
Documentation or (c) authorize a refund, so long as the Software and Documentation are
returned with a copy of your receipt within ninety (90) days of your date of purchase together
with a brief written statement describing the alleged Error.  An "Error" is a defect in the
Software that causes it not to perform substantially in accordance with the limited warranty set
forth above.  Any replacement Software or Documentation will be warranted for the remainder
of the original warranty period only.

No Liability of Suppliers.  You acknowledge that your rights under this Agreement, in the
nature of warranty or otherwise, are solely against Ascend.  NO SUPPLIER MAKES ANY
WARRANTY, ASSUMES ANY LIABILITY, OR UNDERTAKES TO FURNISH TO YOU
ANY SUPPORT OR INFORMATION CONCERNING PRODUCTS OR ANY PORTION OF
PRODUCTS.  You hereby release all Suppliers from any claims, damages or losses arising
from the use of Products, regardless of the form of action.

Disclaimer of Warranties.  EXCEPT AS SPECIFICALLY PROVIDED ABOVE, THE
SOFTWARE AND THE DOCUMENTATION IS PROVIDED "AS IS", WITHOUT
WARRANTY OF ANY KIND.  ALL OTHER WARRANTIES ARE DISCLAIMED,
WHETHER EXPRESS, IMPLIED OR STATUTORY, INCLUDING BUT NOT LIMITED
TO WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR
PURPOSE, NON-INFRINGEMENT OR THAT THE SOFTWARE'S FUNCTIONS WILL



NavisAccess Getting Started                                                                                                   127

MEET YOUR REQUIREMENTS OR THAT ITS OPERATION WILL BE
UNINTERRUPTED OR ERROR FREE.  EXCEPT AS SET FORTH IN THIS AGREEMENT,
THE ENTIRE RISK AS TO THE QUALITY AND PERFORMANCE OF THE SOFTWARE
AND THE DOCUMENTATION IS WITH YOU.  IF THEY PROVE DEFECTIVE AFTER
THEIR PURCHASE, YOU, AND NOT ASCEND OR ITS SUPPLIERS, ASSUME THE
ENTIRE COST OF SERVICE OR REPAIR.  If a disclaimer of implied warranties is not
permitted by law, the duration of any such implied warranty is limited to ninety (90) days from
the date of purchase by the original end user purchaser.  Some jurisdictions do not allow the
exclusion of implied warranties or limitations on how long an implied warranty may last, so
such limitations or exclusions may not apply to you.  This limited warranty gives you specific
legal rights, and you may also have other rights which vary from jurisdiction to jurisdiction.

Liability Exclusions and Limitations.  IN NO EVENT SHALL ASCEND OR ANY SUPPLIER
BE LIABLE FOR ANY INDIRECT, SPECIAL, INCIDENTAL, EXEMPLARY OR
CONSEQUENTIAL DAMAGES OF ANY KIND (INCLUDING LOST PROFITS, LOSS OF
USE OR INTERRUPTION OF BUSINESS), OR FOR LEGAL FEES, ARISING OUT OF
THE USE OF THE SOFTWARE OR THE DOCUMENTATION, REGARDLESS OF THE
FORM OF ACTION, WHETHER IN CONTRACT, TORT (INCLUDING NEGLIGENCE),
STRICT PRODUCT LIABILITY OR OTHERWISE, EVEN IF ASCEND HAS BEEN
ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.  IN NO EVENT WILL
ASCEND'S AGGREGATE LIABILITY FOR ANY CLAIM EXCEED THE LICENSE FEE
PAID BY YOU.  This limitation shall apply notwithstanding any failure or inability to provide
the limited remedies set forth above.  Some jurisdictions do not allow the exclusion or
limitation of incidental or consequential damages, so the above limitation(s) or exclusion(s)
may not apply to you.

Proprietary Rights-Contracts with Certain U.S. Government Agencies.  If the Software is
acquired under the terms of a Department of Defense or civilian agency contract, the Software
is "commercial item" as that term is defined at 48 C.F.R. 2.101 (Oct. 1995), consisting of
"commercial computer software" and "commercial computer software documentation" as such
terms are used in 48 C.F.R. 12.212 of the Federal Acquisition Regulations and its successors
and 48 C.F.R. 227.7202-1 through 227.7202-4 (June 1995) of the DoD FAR Supplement and
its successors.  All U.S. Government end users acquire the Software and the Documentation
with only those rights set forth in this agreement.

Export Restrictions.  You acknowledge that the laws and regulations of the United States
restrict the export and re-export of certain commodities and technical data of United States
origin, including the Software and the Documentation, in any medium.  You agree that you will
not knowingly, without prior authorization if required, export or re-export the Software or the
Documentation in any medium without the appropriate United States and foreign government
licenses.
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Severability.  You acknowledge and agree that each provision of this agreement that provides
for a disclaimer of warranties or an exclusion or limitation of damages represents an express
allocation of risk, and is part of the consideration of this agreement.  Invalidity of any provision
of this Agreement shall not affect the validity of the remaining provisions of this Agreement.

General.  This Agreement is the entire agreement between you and Ascend relative to the
Software and Documentation, and supersedes all prior written statements, proposals or
agreements relative to its subject matter.  It may be modified only by a writing executed by an
authorized representative of Ascend.  No Ascend dealer or sales representative is authorized to
make any modifications, extensions or additions to this agreement.  This Agreement is
governed by the laws of the State of California as applied to transactions taking place wholly
within California between California residents, without application of its conflicts of law
principles.  The United Nations Convention on Contracts for the International Sale of Goods is
specifically excluded from application to this Agreement.

If you have any questions, write or call Ascend Communications, Inc., One Ascend Plaza, 1701
Harbor Bay Parkway, Alameda, CA 94502.
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